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Preface

̈How to read this manual

Thank you for purchasing the TOSHIBA multifunctional digital systems. This manual describes how to use, perform 

maintenance, and fix problems for this equipment. Be sure to read this manual before using this equipment. Keep this 

manual handy and retain it for future reference.

� Symbols in this manual

To ensure correct and safe use of this equipment, this manual describes safety precautions according to the three levels 

shown below.

You should fully understand the meaning and importance of these items before reading this manual.

Other than the above, this manual also describes information that may be useful for the operation of this equipment with 

the following signage:

�Description of original/paper direction

Paper or originals of A4 or B5/LT size can be loaded either in a portrait direction or in a landscape direction. In this manual, 

“-R” is added to this paper size when this size of paper or original is loaded in a landscape direction.

e.g.) A4/LT size paper on the bypass tray

Paper or originals of A3 or B4/LD or LG size can only be loaded in a landscape direction, therefore “-R” is not added to 

these sizes.

Indicates a potentially hazardous situation which, if not avoided, could result in death, serious injury, or 

serious damage, or fire in the equipment or surrounding assets.

Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate 

injury, partial damage of the equipment or surrounding assets, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Describes handy information that is useful to know when operating the equipment.

Pages describing items related to what you are currently doing. See these pages as required.

Loaded in a portrait direction: A4/LT Loaded in a landscape direction: A4-R/LT-R
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� Screens

 In this manual, the screens and the operation procedures in Windows are described for Windows 7.

The details on the screens may differ depending on how the equipment is used, such as the status of the installed 

options, the OS version and the applications.

 The illustration screens used in this manual are for paper in the A/B format. If you use paper in the LT format, the 

display or the order of buttons in the illustrations may differ from that of your equipment.

� Trademarks

 The official name of Windows XP is Microsoft Windows XP Operating System.

 The official name of Windows Vista is Microsoft Windows Vista Operating System.

 The official name of Windows 7 is Microsoft Windows 7 Operating System.

 The official name of Windows 8 is Microsoft Windows 8 Operating System.

 The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating System.

 The official name of Windows Server 2003 R2 is Microsoft Windows Server 2003 R2 Operating System.

 The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating System.

 The official name of Windows Server 2008 R2 is Microsoft Windows Server 2008 R2 Operating System.

 The official name of Windows Server 2012 is Microsoft Windows Server 2012 Operating System.

 Microsoft, Windows, Windows NT, and the brand names and product names of other Microsoft products are 

trademarks of Microsoft Corporation in the US and other countries.

 Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the 

United States and/or other countries.

 Other company and product names given in this manual or displayed in this software may be the trademarks of their 

respective companies.

̈ Lineup of our manuals

These manuals are provided for the operation of the e-STUDIO2505. Select and read the manual best suited to your 

needs. This manual is the User’s Guide.

Safety Information (Printouts)

This manual describes the necessary precautions for use. For your added security, be sure to read this manual first.

Quick Guide (Printouts)

This manual describes the components, preparations, basic operations, and troubleshooting for the equipment.

User’s Guide (PDF file, this manual)

This manual describes preparations for using the e-STUDIO2505, and how to use functions such as copying and printing. 

It also describes maintenance and troubleshooting for the problems that could occur while you are using the equipment.

Software Installation Guide (PDF file)

This manual describes how to install and uninstall printer and scanner drivers.

Help menu for client software

To run the following client software, refer to the Help menu of each:

 Printer driver

 Scanner driver

� To read manuals in the PDF file format

This manual in the PDF (Portable Document Format) can be displayed/printed using Adobe Reader or Adobe Acrobat 

Reader. If neither is installed in your computer, download one of them. This can be done via the website of Adobe Systems 

Incorporated.
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Components

̈ Front/Right/Inner side

1. Automatic Document Feeder (ADF) (optional)

Load up to 50 originals (80 g/m2 or 20 lb. Bond) to scan one sheet after another. (The maximum number you can load 

may vary depending on the type of original.) 

 P.93 “Paper Misfeed”

The Automatic Document Feeder is only available for Europe.

2. Platen cover

Close this before start copying or scanning.

3. Side cover

4. Bypass tray

Place special paper such as thick paper, overhead transparencies, or tracing paper.

 P.19 “Loading paper on the bypass tray”

 P.21 “Loading an envelope on the bypass tray”

5. Drawer

Place up to 250 sheets of plain paper (80 g/m2 or 20 lb. Bond).

 P.17 “Loading paper in the drawer”

6. Front cover

Open this when you replace the toner cartridge.

 P.98 “Replacing Toner Cartridge”

7. Toner cartridge

For the recommended toner cartridges, refer to the Safety Information.

 P.98 “Replacing Toner Cartridge”

2

3
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7

6
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̈ Left side

For Europe

For regions other than Europe

1. Original glass

Place the book-type originals and special paper such as overhead transparencies or tracing paper, as well as plain 

paper.

2. Control panel

Make settings to use the various functions on this equipment.

 P.10 “Control panel”

3. Power switch

Turns the power ON or OFF.

 P.13 “Preparation 1 - Turning Power ON”

4. Paper exit stopper

Stops large paper from sliding out of the receiving tray.

When you use the stopper, pull out it until you hear a click sound.
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5. AC-IN terminal (rear)

Connect the power cable supplied with the equipment.

6. USB terminal (4-pin)

Connect to your PC using a commercially available USB cable.

 Use a USB2.0 Hi-Speed certified cable: USB cable supporting the USB2.0 Hi-Speed mode (480 Mbps of 

transfer speed) certified by the USB Implementers Forum.

 Connect the equipment with a PC directly by the USB cable. When it is connected with a PC via a USB hub, the 

equipment may not be recognized.

7. Receiving tray

8. Scanning area

The data of originals transported from ADF are scanned here.

 P.104 “Regular Cleaning”

The scanning area is only available for Europe.

9. Original scale

Confirm the size of an original placed on the original glass.

10. Platen sheet

 P.104 “Regular Cleaning”

̈Configuration of options

The available options are listed below. Contact your service technician or service representative for details.

̈Control panel

The functions and indications of the  button vary depending on the region. The illustrations show the control panel for 

Europe and the Americas unless they are specified.

Main body

Automatic Document Feeder (MR-2021)

* Only for Europe
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For Europe and the Americas

For regions other than Europe and the Americas

1. LCD screen

Confirms each menu and error messages.

 P.12 “Main screen (Copy)”

2. [USER FUNCTIONS] button

Changes the equipment’s default settings.

 P.87 “User Functions Menu List”

3.  button

Press this button on menu screens to move to the item above. If you press this button when the top menu item is 

highlighted, the bottom menu item is displayed.

4. [SETTINGS] button

Displays the current settings.

5. [ENERGY SAVER] button

Enters into the energy saving mode.

6. [FUNCTION CLEAR] button

Clears the copy function settings and returns to the main screen (Copy).

7. [CLEAR/STOP] button

Stops copying or returns the number of copies to “1”.

8. [START] button

Starts copying.

9. Digital keys

Enters numbers such as the number of copies.

2
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10.  button

Press this button once on the main screen (Copy) to show the “EXPOSURE” screen for Europe and the Americas, or 

the “ID CARD” screen for regions other than Europe and the Americas. Press it on menu screens to move to an item 

on the right or increase the setting.

 P.31 “Using the “EXPOSURE” or “ID CARD” function quickly”

11. [OK] button

Determines the items or operations selected in each menu.

12.  button

Press this button on the main screen (Copy) to enter the copy menu. Press it on menu screens to move to the item 

below. If you press this button when the bottom menu item is highlighted, the top menu item is displayed.

13. [CANCEL] button

Cancels the current settings and returns to the previous item.

14.  button

Press this button once on the main screen (Copy) to show the “ORIGINAL MODE” screen. Press it on menu screens to 

move to an item on the left or decrease the setting.

 P.32 “Selecting “ORIGINAL MODE” quickly”

15. Alert lamp

Blinks or lights in case of an error.

̈Main screen (Copy)

Appears after the power of the equipment is turned ON and the warm-up is finished. This screen is called “main screen 

(Copy)”.

1. Message

Displays the current status or error messages.

2. Paper size

Displays the paper size specified for the drawer or the bypass tray.

3. Copy quantity

Displays the number of copies.

4. Scroll icon

Displays  or  that you can press on the current screen or menu.

5. Original mode

Displays the mode to copy the original.

6. Exposure

Displays the copy density.

7. Reproduction ratio

Displays the reproduction or zoom ratio to copy.

A41

READY

100%

AUTO EXPOSURE

TEXT/PHOTO

2

5
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1 3
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Preparation 1 - Turning Power ON

̈ Turning on

Press the power switch to “ ” (on).

Starts warming up, which takes approx. 20 seconds. When the warm-up has finished, the equipment is ready.

 If the access code function is enabled, press the [FUNCTION CLEAR] button after any operation has been finished 

to prevent unauthorized use of the equipment.

For the details of the access code setting, ask your service technician.

 If you press [START] during the warm-up, copying automatically starts after it has finished. When the job is 

reserved, “COPYING” appears on the LCD screen to show you the current status.

This function cannot be accessed while “PLEASE WAIT” is being displayed (approx. 15 seconds).

� Turning off

Press the power switch to “ ” (off).

̈ Saving energy when not in use - Energy saving mode -

To reduce power consumption, the equipment automatically enters into the energy saving mode when a specified period 

of time has passed since its last use. You can also switch the equipment into this mode manually.

There are two types of the energy saving mode; the low power mode and sleep mode.

� Types of energy saving mode

Low power mode: “SAVING ENERGY” appears on the LCD screen.

Sleep mode: The LCD screen disappears.

The timers for “AUTO POWER SAVE” and “SLEEP MODE” have been set respectively as the factory default settings. 

You can change them in the “USER FUNCTIONS” menu.

 P.87 “User Functions Menu List”

A41

READY

100%

AUTO EXPOSURE

TEXT/PHOTO
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� To turn the equipment into the energy saving mode manually

Press [ENERGY SAVER].

Canceling conditions for energy saving mode

The energy saving mode is canceled under the following conditions.

 When [ENERGY SAVER] or [START] on the control panel is pressed

- For the low power mode: Press [ENERGY SAVER] or [START]

- For the sleep mode: Press [ENERGY SAVER]

 When printing or scanning is performed from a PC connected with this equipment
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Preparation 2 - Loading Paper

Load an appropriate type of paper.

̈Acceptable paper types

Acceptable paper types differ depending on its paper source. See the table below for more details.

*1 “Maximum sheet capacity” refers to the maximum number of sheets when recommended paper is used. See the following pages for the 

recommended paper: 

 P.16 “Recommended paper”

*2 Be sure to use the recommended overhead transparencies. Using other transparencies could cause an equipment malfunction.

*3 Envelope can be used when printing from your PC.

 Do not mix various paper sizes in one drawer.

 “LT format” is the standard size for only use in North America.

 “K format” is a Chinese standard size.

Abbreviations for LT format sizes:

LT: Letter, LD: Ledger, LG: Legal, ST: Statement, COMP: Computer

Paper source Paper type Paper size Maximum sheet capacity*1

Drawer Plain paper

(64 - 80 g/m2, 17 - 20 lb. Bond)

A/B format: A4

LT format: LT

K format: 16K

250 sheets

(80 g/m2, 20 lb. Bond)

Bypass tray Plain paper

(64 - 80 g/m2, 17 - 20 lb. Bond)

A/B format:

A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO

LT format:

LD, LG, LT, LT-R, ST-R, COMP, 13"LG, 

8.5"SQ

K format:

8K, 16K, 16K-R

50 sheets

(80 g/m2, 20 lb. Bond)

Thin

(52 - 63 g/m2, 14 - 17 lb. Bond)

1 sheet

(52 - 63 g/m2, 14 - 17 lb. Bond)

Thick paper 1

(81 - 105 g/m2, 21 - 28 lb. Bond)

1 sheet

(81 - 105 g/m2, 21 - 28 lb. Bond)

Thick paper 2

(106 - 163 g/m2, 28 - 43 lb. Bond)

1 sheet

(106 - 163 g/m2, 28 - 43 lb. Bond)

Tracing paper

(75 g/m2, 20 lb. Bond)

1 sheet

Sticker labels 1 sheet

Transparencies*2 A4/LT only 1 sheet

Envelope*3 DL (110 mm x 220 mm), COM10 (4 1/8" x 

9 1/2"), Monarch (3 7/8" x 7 1/2"), CHO-3 

(120 mm x 235 mm), YOU-4 (105 mm x 

235 mm)

1 sheet
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̈Recommended paper

To ensure the best copy performance, the paper types listed below are recommended. If you want to use paper other than 

that we recommend, contact your service technician.

*1 Be sure to use the recommended overhead transparencies. Using other transparencies could cause an equipment malfunction.

� Paper types not acceptable

Do not use the types of paper listed below since they may cause paper misfeeds.

 Damp paper

 Creased paper

 Wrinkled paper or paper prone to be curled

 Extremely smooth or rough surface paper

Do not use the types of paper listed below since they may cause an equipment malfunction.

 Paper whose surface is specially treated

 Paper once printed with other copiers or printers

� Storing paper

Note the following points when storing paper.

 Wrap the paper in its packaging to prevent it from gathering dust.

 Do not expose the paper to direct sunlight.

 Do not store the paper in a humid location.

 Store the paper on a flat surface to prevent it from becoming curled or creased.

Paper type Product name

Plain paper A/B format: TGIS Paper/Mondi

LT format: TIDAL/Hammermill
80 g/m2, 20 lb. Bond

K format: Classic Jetset COPY PAPER/UPM 70 g/m2

Thick paper 1 A/B format: Color Copy/Mondi

LT format: Laser/Hammermill
90 g/m2, 24 lb. Bond

A/B format: Color Copy/Mondi 100 g/m2

Thick paper 2 A/B format: Color Copy/Mondi

LT format: Laser/Hammermill
120 g/m2, 32 lb. Bond

A/B format: Color Copy/Mondi

LT format: Exact Index/WAUSAU
160 g/m2, 43 lb. Index

Tracing paper Tracing paper/Ostrich International 75 g/m2 only, 20 lb. Bond only

Sticker labels A/B format: 3478/ZWECH-AVERY

LT format: 5165/AVERY

Transparencies *1 A/B format: PP2500/3M

LT format: X10.0/FOLEX

Envelope COM10/ColumbianCO138/Westvaco,

No.553/Monarch/mailwell
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1 PREPARATION

̈ Loading paper in the drawer

For the acceptable paper, see the following pages:

 P.15 “Acceptable paper types”

1 Turn the power of the equipment ON.

2 Pull out the drawer carefully, and then press down the paper plate.

Press it down until you hear a click sound and it is no longer lifted up.

3 Remove the side guides.

4 Attach the side guides according to the paper size.

1

2

1

2

2
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5 Load paper face up in the drawer.

 Up to 250 sheets (80 g/m2 or 20 lb. Bond) can be loaded. Be sure that the height of the stacked paper does 

not exceed the line indicated inside of the trailing guides.

 P.15 “Acceptable paper types”

 Fan the paper well before loading it in the drawer, otherwise multiple feeding could occur. Be careful not to 

cut your fingers.

 The printable side may be noted on its packaging.

6 Move the end guide to the trailing edge of the paper while pushing its lower part in the 

direction of the arrows.

Widen the gap with both hands.

7 Push the drawer straight into the equipment slowly until it stops.

Do not catch your fingers in the drawer when closing it.

This could cause injury.

Register the paper size into the equipment.

When you load paper in the drawer for the first time, register the paper size. Be sure to register it correctly, otherwise it 

could cause a paper misfeed.

For the registration, see the following pages:

 P.24 “Preparation 3 - Registering Paper Size and Type”

Be sure to register the paper size each time you have changed it.
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1 PREPARATION

̈ Loading paper on the bypass tray

The contents of the original(s) are rotated when copied on paper of the following sizes fed from the bypass tray.

A/B format: A3, A4-R, A5-R, B4, B5-R, FOLIO

LT format: LD, LG, LT-R, ST-R, COMP, 13"LG, 8.5"SQ

K format: 8K, 16K-R

For example, to copy an A5-size original, place the original on the original glass in A5 portrait orientation and paper on 

the bypass tray in A5 landscape orientation (A5-R).

To enlarge an A4-size original to A3, place the original on the original glass in A4 portrait orientation and A3 paper on 

the bypass tray.

The illustrations below are example of loading A4/LT size paper.

For the acceptable paper, see the following pages:

 P.15 “Acceptable paper types”

1 Open the bypass tray.

2 Release the lever on the left, and then load paper face down and straight on the bypass 

tray.

The printable side may be noted on its packaging.

1

2
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3 Align the side guides with the edges of the paper, and then push back the lever.

 Up to 50 sheets of plain paper (80 g/m2 or 20 lb. Bond) can be loaded. Be sure that the height of the stacked 

paper does not exceed the indicators of the side guides. If paper other than plain is used, set it one sheet at 

a time.

 Fan the paper well before loading it on the bypass tray, otherwise multiple feeding could occur. Be careful 

not to cut your fingers.

 Do not push the paper forcibly into the entrance of the bypass feeder, otherwise it could cause a paper 

misfeed.

When you use paper longer than the bypass tray size, pull out the paper holder from the tray, and then open it.

1 2

1

2
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1 PREPARATION

̈ Loading an envelope on the bypass tray

For the acceptable envelope sizes, see the following pages:

 P.15 “Acceptable paper types”

Notes for using envelopes

Do not use the following envelopes, otherwise they may cause a paper misfeed or damage to the equipment.

1. Badly curled, wrinkled or folded envelopes

2. Extremely thick or thin envelopes

3. Wet or damp envelopes

4. Torn envelopes

5. Envelopes which include the contents

6. Non-standard size envelopes (ones with a special shape)

7. Envelopes with eyelets or windows

8. Envelopes sealed with adhesive paste or tape

9. Partly-opened or perforated envelopes

10. Envelopes with special coating on the surface

11. Envelopes with glue or double-sided adhesive tape

Store envelopes at room temperature and away from heat and moisture.

2

5  6
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1 Place an envelope on a flat clean surface and press it with your hands in the arrow 

directions as shown below to expel air from the inside.
Press it well to prevent the flap from rolling upward.

Correct bent corners of the envelope.

2 Open the bypass tray.

3 Release the lever on the left, and then load the envelope face down on the bypass tray.
Place the envelope with its flap side at the front as shown below.

Do not copy or print on the back of envelopes, otherwise it may cause a paper misfeed or soil them or the inside 

of the equipment.

1

2
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1 PREPARATION

4 Align the side guides to the edges of the envelope, and then push back the lever.

1 2
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Preparation 3 - Registering Paper Size and Type

When you load or change paper, a pop-up window appears. Follow the instructions to register the items below in the 

equipment.

 For the drawer: the paper size

 For the bypass tray: the paper size and type

You can also register the paper size for the drawer in the “USER FUNCTIONS” menu.

 P.87 “User Functions Menu List”
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Basic Copy Procedure

Learn the basic copy procedure in this section. For the other various functions, see the following pages:

 P.33 “Copy Settings”

Make sure that the equipment is ready to copy.

 P.13 “Preparation 1 - Turning Power ON”

 P.15 “Preparation 2 - Loading Paper”

 P.24 “Preparation 3 - Registering Paper Size and Type”

̈Acceptable originals

Acceptable originals differ depending on the setting position. See the table below for more details.

If you are using the Automatic Document Feeder, you can automatically scan a stack of plain paper originals at one time. 

*1 The automatic size detection function is only available when the Automatic Document Feeder is installed.

*2 The maximum number of sheets acceptable varies depending on the type of original.

�Maximum number of originals scanned at one time

You can scan up to 50 original sheets at one time. When the number of sheets to be scanned exceeds 50 or the built-in 

memory in the equipment is full, scanning stops and an error message is displayed on the LCD screen. To copy the data 

scanned so far, select “PRINT”. To delete them, select “CANCEL JOB”.

� Precautions for Automatic Document Feeder

Do not use the following types of original as they may cause a paper misfeed or damage to the equipment:

 Originals that are folded or curled

 Originals with carbon copies

 Originals that have been taped, pasted, or cut-out

 Originals that have been clipped or stapled

 Originals with holes or tears

 Originals that are damp

 Overhead transparencies or tracing paper

 Coated paper (e.g. coated with wax)

 Originals with multiple holes punched (e.g. loose leaf paper)

The following types of originals can be used but need extra care:

 Originals that you cannot slide with your fingers or whose surface is specially treated (they may not be able to be 

separated from each other at feeding)

 Originals that are folded or curled (should be smoothed out before being used)

When black streaks appear

If the scanning area or the guide area is dirty, image problems such as black streaks may occur. Weekly cleaning of these 

areas is recommended.

 P.104 “Regular Cleaning”

Setting position Type Maximum size
Acceptable sizes for 

automatic size detection*1

Maximum number of 

sheets

Original glass Plain paper

Special paper

Booklets

A4 or LT - -

Automatic Document 

Feeder

Plain paper

(50 - 104 g/m2, 13 - 27 lb. 

Bond)

A3 or LD A/B format:

A3, A4, A4-R, A5-R, B4, B5, B5-R

LT format:

LD, LG, LT, LT-R, ST-R, COMP

K format:

8K, 16K, 16K-R

50 sheets (80 g/m2, 20 lb. 

Bond)

(or stack height 9.5 mm)*2
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̈Copying originals

Follow the common basic instructions below to make a copy.

1 Place the original(s).

 Placing originals on the original glass

1) Raise the platen cover or the Automatic Document Feeder.

2) Place the original face down on the original glass.

3) Align the original with the top-left corner of the original glass.

4) Lower the platen cover or the Automatic Document Feeder carefully.

Do not place heavy objects (4 kg/8.8 lb. or over) on the original glass and do not force it down.

It may breaks the glass and could cause injury.

 When you copy originals with folds or wrinkles, smooth out the folds and wrinkles first. Then, place the 

original on the original glass and close the platen cover or the Automatic Document Feeder to start copying.

 If a shadow of the folds or wrinkles appears on copies although you smooth out them, adjust the exposure 

or use the “BACKGROUND ERASE” function.

When you use the transparent original such as overhead transparencies and tracing paper, place a blank plain 

sheet of paper - the same size or a larger sheet - over the original, otherwise the copied image could be 

stained.
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 Placing originals on the Automatic Document Feeder

1) Align all the originals.

2) Place them face up and align the side guides to the original length.

 The top sheet of the originals will be scanned first.

 Do not load more than 50 originals (80 g/m2, 20 lb. Bond) at once, and make sure the thickness of the stack 

of originals does not exceed 9.5 mm regardless of their size.

 When placing long originals (A3, B4, A4-R, LD, LG, COMP, or 8K), open the original holder so that the size 

of the original can be detected correctly.

 To prevent long originals (A3, B4, A4-R, LD, LG, COMP, or 8K) from sliding out when, extend the paper exit 

stopper and raise the sub-stopper. When you have finished using the stopper, lift it slightly and slide it back 

in.

1
2
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2 Enter the number of copies with the digital keys.

3 Make the copy settings as required.
 P.33 “Copy Settings”

You may not be able to use some combinations of functions.

 P.110 “Copying Function Combination Matrix”

4 Press [START] to start copying.

To stop or resume copying, press [CLEAR/STOP] during copying.

Press [OK] or [CANCEL] according to the message displayed on the LCD screen.

When the copying has finished, press [FUNCTION CLEAR] to clear the set copy functions and return to the main 

screen (Copy).
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 If the paper source runs out of paper, an error message is displayed on the LCD screen and copying stops. Load 

paper. The equipment automatically resumes copying after approx. 3 seconds have passed.

 The receiving tray can hold up to 100 sheets. If the excessive paper error occurs, the lamp blinks and an error 

message is displayed on the LCD screen. Remove the paper from the tray and press [START] to resume copying.

 When you use overhead transparencies, remove them one by one every time they are ejected. Otherwise, they 

could be curled and not be good for projection.
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� Shortcut keys

You can access some functions by simply pressing a button.

 P.31 “Using the “EXPOSURE” or “ID CARD” function quickly”

 P.32 “Selecting “ORIGINAL MODE” quickly”

Using the “EXPOSURE” or “ID CARD” function quickly

On the first screen of Copy mode, the  button function varies depending on the region. It can work as the [EXPOSURE] 

button for Europe and the Americas, or the [ID CARD] button for regions other than Europe and the Americas. Just press 

the button to access the “EXPOSURE” or “ID CARD” function so that you can change the copy density, or you can copy 

the front and back of a card on a sheet of paper.

 P.33 “Adjusting the exposure”

 P.43 “Copying both sides of a card on a sheet”

For Europe and the Americas

For regions other than Europe and the Americas

AUTO EXPOSURE

TEXT/PHOTO

A41

READY

100%

EXPOSURE

AUTO

AUTO EXPOSURE

TEXT/PHOTO

A41

READY

100%

ID CARD

OFF

ON
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Selecting “ORIGINAL MODE” quickly

On the first screen of Copy mode, the  button can work as the [ORIGINAL MODE] button. Just press the button to 

access the “ORIGINAL MODE” function so that you can change the original mode.

 P.34 “Selecting the original mode”

For Europe and the Americas

For regions other than Europe and the Americas

AUTO EXPOSURE

TEXT/PHOTO

A41

READY

100%

ORIGINAL MODE

TEXT/PHOTO

TEXT

PHOTO

AUTO EXPOSURE

TEXT/PHOTO

A41

READY

100%

ORIGINAL MODE

TEXT/PHOTO

TEXT

PHOTO
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Copy Settings

You can make the copy settings on the copy functions menu.

Press [CANCEL] to exit from the setting without making any changes. You can also exit by pressing  if it is active.

̈Adjusting the exposure

You can adjust the density to make copies lighter or darker in nine levels from -4 to +4. The auto density setting can 

represent the copy image in the middle density status.

You can directly access this function by pressing . The button operation varies depending on the region.

For Europe and the Americas:

 P.31 “Using the “EXPOSURE” or “ID CARD” function quickly”

1 Press  or  to select the item displayed on the LCD screen, and then press .

2 Press  or  to select the setting item.

3 Adjust the density as follows.
For “AUTO”:

Press [OK].

For manual:

1) Press  or  to increase or decrease the density level.

2) Press [OK].

Menu Functions Settings Description

EXPOSURE AUTO Adjusts the density automatically.

Manual Adjusts the density manually.

A41

READY

100%

AUTO EXPOSURE

TEXT/PHOTO
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̈ Selecting the original mode

You can select suitable original image to copy.

You can directly access this function by pressing .

 P.32 “Selecting “ORIGINAL MODE” quickly”

1 Press  or  to select the item displayed on the LCD screen, and then press .

2 Press  or  to select the setting item, and then press [OK].

Menu Functions Settings Description

ORIGINAL MODE TEXT/PHOTO Text and photographs mixed.

TEXT Text only or text and fine illustration only.

PHOTO Photographs only.

BACKGROUND ERASE Dark background is placed.

A41

READY

100%

AUTO EXPOSURE

TEXT/PHOTO
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̈ Selecting the paper

You can select the paper source in which the paper of the desired size and type is loaded.

 P.15 “Acceptable paper types”

� Selecting the paper source

1 Press  or  to select the item displayed on the LCD screen, and then press .

2 Press  or  to select the setting item.
To select the paper size:

1) Press .

2) Press  or  to select the paper size, and then press [OK].

To accept the setting:

Press [OK].

Menu Functions Settings Description

DRAWER Drawer 1 XX Uses the drawer as the paper source. The variable “XX” indicates 

the paper size.

Bypass XX Uses the bypass tray as the paper source. Available only when 

the paper is loaded on the bypass tray. The variable “XX” 

indicates the paper size.

APS Automatic Paper Selection. Detects the size of the original and 

selects paper of the same size automatically. Available only when 

the original is placed on the Automatic Document Feeder.

 This function may not work properly for totally dark originals or originals with dark borders.

 When placing long originals (A3, B4, A4-R, LD, LG, COMP, or 8K), open the original holder 

so that the size of the original can be detected correctly.

For the detectable original sizes, see the following page:

 P.26 “Acceptable originals”

A41

READY

100%

TEXT/PHOTO

A41
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� Selecting the bypass tray automatically

When you load paper into the bypass tray, the paper source automatically changes from the drawer to the bypass tray. 

The LCD screen automatically changes so that you can easily set the paper size and type for the bypass tray.

1 Press  or  to select the paper size, and then press [OK].

2 Press  or  to select the paper type, and then press [OK].

Remove the paper from the bypass tray after copying is finished. The paper source automatically changes back to the 

drawer.

BYPASS

A3

A4

A4-R

BYPASS PAPER TYPE

PLAIN

THICK1

THICK2
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̈ Enlarging or reducing the copy size

You can enlarge or reduce the size of copies in the following three ways.

 Specify the ratio manually ( P.37)

 Select a fixed zoom ratio ( P.38)

 Automatic Magnification Selection (AMS) ( P.39)

� Specifying the ratio manually

1 Press  or  to select the item displayed on the LCD screen, and then press .

2 Press  or  to select the setting item for manual zoom.
When manual zoom is already selected, this step is not necessary.

3 Press  or  to increase or decrease the zoom ratio, and then press [OK].
You can keep pressing the button to adjust the ratio quickly.

Menu Functions Settings Description

ZOOM Manual zoom (25 - 100 - 400%) Adjusts the ratio manually.

FIXED ZOOM A/B format:

71% (A4 -> A5), 141% (A4 -> A3), 

200% (A5 -> A3), 300%, 400%

LT format:

65% (LT -> ST), 100% (LT -> LG), 

129% (LT -> LD / ST-> LT), 

154% (ST -> LG), 200% (ST -> LD), 300%, 

400%

K format:

71% (A4 -> A5), 76% (16K -> A5), 

91% (A4 -> 16K), 108% (16K -> A4), 

129% (A4 -> 8K / A5 -> 16K), 

138% (16K -> 8K), 

141% (A4 -> A3 / A5 -> A4), 

152% (16K -> A3), 182% (A5 -> 8K), 

200% (A5 -> A3), 300%, 400%

 P.38 “Selecting a fixed zoom ratio”

AMS  P.39 “Automatic magnification 

selection (AMS)”

A41

READY

100%

100%

A41

ZOOM

- 100% +

FIXED ZOOM

AMSAMS
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� Selecting a fixed zoom ratio

1 Press  or  to select the item displayed on the LCD screen, and then press .

2 Press  or  to select “FIXED ZOOM”, and then press .

3 Press  or  to select a zoom ratio, and then press [OK].

Menu Functions Settings Description

ZOOM Manual zoom (25 - 100 - 400%)  P.37 “Specifying the ratio 

manually”

FIXED ZOOM A/B format:

71% (A4 -> A5), 141% (A4 -> A3), 

200% (A5 -> A3), 300%, 400%

LT format:

65% (LT -> ST), 100% (LT -> LG), 

129% (LT -> LD / ST-> LT), 

154% (ST -> LG), 200% (ST -> LD), 300%, 

400%

K format:

71% (A4 -> A5), 76% (16K -> A5), 

91% (A4 -> 16K), 108% (16K -> A4), 

129% (A4 -> 8K / A5 -> 16K), 

138% (16K -> 8K), 

141% (A4 -> A3 / A5 -> A4), 

152% (16K -> A3), 182% (A5 -> 8K), 

200% (A5 -> A3), 300%, 400%

Selects a fixed zoom ratio.

AMS  P.39 “Automatic magnification 

selection (AMS)”

A41

READY

100%

100%

A41

ZOOM

- 100% +

FIXED ZOOM

AMSAMS
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�Automatic magnification selection (AMS)

1 Press  or  to select the item displayed on the LCD screen, and then press .

2 Press  or  to select “AMS”, and then press [OK].

Menu Functions Settings Description

ZOOM Manual zoom (25 - 100 - 400%)  P.37 “Specifying the ratio 

manually”

FIXED ZOOM A/B format:

71% (A4 -> A5), 141% (A4 -> A3), 

200% (A5 -> A3), 300%, 400%

LT format:

65% (LT -> ST), 100% (LT -> LG), 

129% (LT -> LD / ST-> LT), 

154% (ST -> LG), 200% (ST -> LD), 300%, 

400%

K format:

71% (A4 -> A5), 76% (16K -> A5), 

91% (A4 -> 16K), 108% (16K -> A4), 

129% (A4 -> 8K / A5 -> 16K), 

138% (16K -> 8K), 

141% (A4 -> A3 / A5 -> A4), 

152% (16K -> A3), 182% (A5 -> 8K), 

200% (A5 -> A3), 300%, 400%

 P.38 “Selecting a fixed zoom ratio”

AMS Detects the size of the original and 

automatically sets the optimum zoom 

ratio for the paper size. Available only 

when the original is placed on the 

Automatic Document Feeder.

 This function may not work properly for totally dark originals or originals with dark borders.

 When placing long originals (A3, B4, A4-R, LD, LG, COMP, or 8K), open the original holder so 

that the size of the original can be detected correctly.

For the detectable original sizes, see the following page:

 P.26 “Acceptable originals”

A41

READY

100%

100%

A41

ZOOM

- 100% +

FIXED ZOOM

AMSAMS
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̈ Sorting pages

You can sort a number of copied pages in the same order as the original.

NON SORT: Not to sort the copied pages. All copies of the first page are ejected first and then all copies of 

subsequent pages are ejected in sequence.

SORT: Sorts the copied pages in the same order as the original and eject all sets of copies in the same 

orientation.

When an original is placed on the Automatic Document Feeder, “SORT” is automatically set.

1 Press  or  to select the item displayed on the LCD screen, and then press .

2 Press  or  to select the setting item, and then press [OK].

3 Specify the number of copies to “2” or more.
 P.27 “Copying originals”

When placing the original on the original glass

After the first original is scanned, the LCD screen shows “NEXT ORIGINAL?”.

Make sure that “SCAN NEXT PAGE” is selected, place the next original on the original glass, and then press [OK] or 

[START]. When all the originals have been scanned, select “FINISHED”, and then press [OK] or [START] to start copying 

the scanned originals.

“CANCEL JOB?” is displayed if there is no operation for a certain period.

Menu Functions Settings

FINISHING NON SORT

SORT

A41

READY

100%

100%

NON SORT
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̈Copying two or four pages on each sheet

You can copy two or four original pages on each sheet of paper.

OFF: Disables this function.

2IN1: Copies two pages on a sheet of paper.

4IN1: Copies four pages on a sheet of paper.

 You need to make settings to use the “2IN1/4IN1” function from “USER FUNCTIONS” - “COPY” - “2IN1/4IN1”.

 P.88 “User functions menu items”

 This function is not available for some paper sizes. If you have set the unavailable sizes, the LCD screen shows the 

error message and you cannot use this function.

 P.15 “Preparation 2 - Loading Paper”

 P.24 “Preparation 3 - Registering Paper Size and Type”

When an original is placed on the Automatic Document Feeder, “APS” or “AMS” is automatically set.

 P.35 “Selecting the paper”

 P.37 “Enlarging or reducing the copy size”

1 Press  or  to select the item displayed on the LCD screen, and then press .

2 Press  or  to select the setting item, and then press [OK] or .

Menu Functions Settings

2IN1/4IN1 OFF

2IN1

4IN1

A41

READY

100%

NON SORT

2IN1/4IN1:OFF
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3 Follow the instructions on the LCD screen to use the “2IN1/4IN1” function. You are 

instructed to make the following settings.
 ORIGINAL SIZE

Press  or  to select the size of the original.

 ORIG. ORIENTATION

Press  or  to select the portrait or landscape orientation of the original.

 SET ORIGINAL

Place the originals as shown on the LCD screen. Make sure that you place the original in the same orientation 

as the one selected in “ORIG. ORIENTATION”.

 NEXT ORIGINAL?

When you place the original on the original glass, this message appears. Press  or  to select “SCAN NEXT 

PAGE”. Select “FINISHED” when you have finished scanning your originals.

“CANCEL JOB?” is displayed if there is no operation for a certain period.
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 Copying both sides of a card on a sheet

You can copy the front and back of a card on a sheet of paper.

You can directly access this function by pressing . The button operation varies depending on the region.

For regions other than Europe and the Americas:

 P.31 “Using the “EXPOSURE” or “ID CARD” function quickly”

1 Press  or  to select the item displayed on the LCD screen, and then press .

2 Press  or  to select the setting item, and then press [OK].

3 Follow the instructions on the LCD screen to use the “ON” function. You are instructed 

to make the following settings.
 SET FRONT OF ID CARD

Place the front of a card face down on the original glass, and then press [START].

Make sure that you place the card in a landscape orientation within the frame of the original scale.

 SET BACK OF ID CARD

Turn over the card and place the back surface face down on the original glass, and then press [START].

“CANCEL JOB?” is displayed if there is no operation for a certain period.

Menu Functions Settings

ID CARD OFF

ON

Front side Back side

A41

READY

100%

2IN1/4IN1:OFF

ID CARD:OFF
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̈ Erasing the shadow on edges

You can erase the shadow on the edges of copies. When you copy thick books, you can erase the surrounding shadow 

with this function. The area to erase can be changed from 4 mm to 15 mm (0.2" to 0.6") in increments of 1 mm (0.04").

1 Press  or  to select the item displayed on the LCD screen, and then press .

2 Press  or  to select the setting item.

3 Set the setting as follows.
For “OFF”:

Press [OK].

For “ON”:

1) Press  or  to increase or decrease the value for the area to erase.

2) Press [OK].

If you just press [OK] for “ON”, the default value of this function is used.

Menu Functions Settings

EDGE ERASE OFF

ON

A41

READY

100%

ID CARD:OFF

EDGE ERASE:OFF
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̈ Shifting the pages to the right or left

You can shift pages to the right or left. The shifted area can be used as a margin for punching holes or stapling. The 

margin can be changed from 4 mm to 15 mm (0.2" to 0.6") in increments of 1 mm (0.04").

1 Press  or  to select the item displayed on the LCD screen, and then press .

2 Press  or  to select the setting item.

3 Set the setting as follows.
For “OFF”:

Press [OK].

For “LEFT MARGIN” or “RIGHT MARGIN”:

1) Press  or  to increase or decrease the value for the margin.

2) Press [OK].

Menu Functions Settings

IMAGE SHIFT OFF

LEFT MARGIN

RIGHT MARGIN

A41

READY

100%

EDGE ERASE:OFF

IMAGE SHIFT:OFF
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̈Adding a page number on the copied paper

You can add a page number on the copied paper.

1 Press  or  to select the item displayed on the LCD screen, and then press .

2 Press  or  to select the setting item, and then press [OK].

Menu Functions Settings

ANNOTATION OFF

PAGE NO.

3

2

1

3

2

1

Printed at the bottom center
of a portrait copy

Printed at the top right
of a landscape copy

A41

READY

100%

IMAGE SHIFT:OFF

ANNOTATION:OFF
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̈Confirming the current function settings

1 Press [SETTINGS].

2 Press  or  to scroll through the menu.
For details on the displayed functions and settings, see the pages below.

 P.86 “Copy menu items”

3 When you are finished with confirmation, press [SETTINGS] again.
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Before Using the Printer Driver

Before printing, you have to configure the following options:

 Configuration Settings

To use devices installed in this equipment, you must first configure their options on the [Configuration] tab of the printer 

driver.

 P.50 “Configuring the options”

̈Configuring the options

To use this equipment properly, you need to save the configuration of the device options on the [Configuration] tab after 

you installed the printer drivers.

�Configuring options manually

Setting the [Configuration] tab manually

You need to log in to Windows with the “Administrator” privilege.

1 Click [Start] and select [Devices and Printers].
The Printers folder appears.

 For Windows Vista or Windows Server 2008

Click [Start], [Control Panel], [Hardware and Sound] and select [Printers].

 For Windows XP or Windows Server 2003

Click [Start] and select [Printers and Faxes].

 For Windows 8 or Windows Server 2012, see the procedures in the following section.

 P.53 “Accessing the printers folder on Windows 8 / Windows Server 2012”
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2 Select your printer, and then click [Printer properties] in the [File] menu.
The printer driver properties dialog box appears.

 For Windows XP / Windows Vista / Windows Server 2003 / Windows Server 2008, click [Properties] in the [File] 

menu and select your printer.

 If the [File] menu is not displayed, press [Alt].

 If the dialog box displayed does not allow the printer driver properties to be changed, follow the procedure 

below.

- For Windows Vista, click [Run as administrator] and [Properties] in the [File] menu.

If the password entry screen appears, enter the administrator password.

The [User Account Control] dialog box appears. Click [Continue].

- For Windows 7, some tab menus have a  button in the printer driver properties. To change the 

properties, click on it. If the properties cannot be changed, ask your system administrator.

3 Display the [Configuration] tab menu, and click [Drawer Settings].

The [Drawer Settings] dialog box appears.
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4 Set the following options and click [OK].

Drawer 1 — Select the size of paper that is loaded in the Drawer. The paper type for the drawer is fixed to “Plain”.

Bypass Tray — Select the size and type of paper that is loaded in the Bypass Tray.

 Setup items differ depending on the model and the option configuration.

 For more information about each item, see the descriptions about the Drawer Settings.

 P.70 “Drawer Settings”

5 Click [Apply] or [OK] to save settings.
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Accessing the printers folder on Windows 8 / Windows Server 2012

Follow the steps below to access the printers folder on Windows 8 / Windows Server 2012.

1 Move the cursor to the upper right corner or lower right corner of the computer screen, 

and then select [Start] in the menu that appears.

The [Start] screen appears.

2 Right-click in the blank area in the [Start] screen, and then click [All apps] that appears.

The [Apps] screen appears.
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3 Click [Control Panel].

The [All Control Panel Items] screen appears.

4 Click [Devices and Printers].

The [Devices and Printers] folder appears.
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Printing From Application

This section describes how to print a document from application.

 P.55 “Considerations and limitations”

 P.55 “How to print”

̈Considerations and limitations

 Some print options can be set from both the application and the printer driver, such as collation. If the collation is set 

from the application, documents may not be properly printed. If that happens, use the printer driver to set the collation. 

Depending on the application, some print options such as the orientation need to be set from the application. For print 

options that can be set from both the application and the driver, refer to the manual of the application.

 When you print from your PC while another user uses the equipment for copying, the printing starts after approx. 30 

seconds have passed since another user finishes the operation for copying.

̈How to print

Once you have installed the printer driver and configured it properly, you can print directly from most Windows 

applications. Simply choose the Print command from your application.

You can print using the various functions by setting print options on the printer driver.

Printing from Windows applications

The following describes an example for printing from Notepad on Windows 7.

1 Open a file and select [Print] from the application’s [File] menu.
The [Print] dialog box appears.

2 Select your printer, and then click [Preferences].

The printing preferences dialog box appears.

The procedures for displaying the properties dialog for the printer driver may be different depending on the application 

that you are using. See your application’s manual about displaying the printer properties dialog box.
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3 Setting the print options on each tab according to how you want to print.

 Setting the print options varies depending on how you want to print a document.

 P.60 “Print options”

4 Click [OK] to save the settings.

5 Click [Print] to print a document.
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Setting Up Print Options

Print Options are the attributes you set to define the way a print job is processed.

To find the printing instructions for your specific needs, see the procedures in the following section.

 P.71 “Printing With Best Functions for Your Needs”

̈How to set up

There are several ways to set print options. How the settings affect printing varies depending on the way you set the 

options. The tabs displayed also vary depending on how you display the printer properties.

� Setting initial values of print options

Setting the print options by displaying the printer properties from the Printers folder within the Windows Start menu will 

establish the initial values of the options. For example, the paper size setting you most commonly use, user information 

settings, etc., are settings you will not want to change every time you print. It is convenient to set these options as initial 

values.

How to display:

1  Click [Start] and select [Devices and Printers].

 For Windows Vista or Windows Server 2008

Click [Start], [Control Panel], [Hardware and Sound] and select [Printers].

 For Windows XP or Windows Server 2003

Click [Start] and select [Printers and Faxes].

 For Windows 8 or Windows Server 2012, see the procedures in the following section.

 P.53 “Accessing the printers folder on Windows 8 / Windows Server 2012”

2 Select your printer, and then click [Printing preferences] in the [File] menu.

� Setting print options for each print job

The print options that are set in properties dialog box, which can be accessed from the [Print] dialog box of the application, 

are only applied to the current print job, so once you close the application, the options will be invalid.

How to display:

1 Click the [File] menu and select [Print] on application.

2 Select your printer, and then click [Preferences].
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� Setting print options using profiles

Using profiles, you can save the print settings or apply the saved settings to a print job.

In order to print a document using profiles, you must first create the saved profile.

 P.58 “Saving profile”

Once you save a profile, you can apply its settings to a print job.

 P.59 “Loading profile”

You can also delete unnecessary profiles.

 P.59 “Deleting profile”

Saving profile

You can register up to 20 profiles for each printer driver.

1 Configure the print options on each tab.
Setting the print options varies depending on how you want to print a document.

 P.60 “Print options”

2 Click [Save Profile] in the Profile group.

The [Profile Name] dialog box appears.

3 Enter the profile name and click [OK].

The file name must be up to 63 characters long.

 If you enter an existing profile name, you are prompted to confirm whether you want to overwrite it. If you 

want, click [OK].

 If you try to save more than 20 profiles, a dialog box notifying you that no more can be saved appears, then 

the 21st profile is saved as a temporary profile. If you want to register this temporary profile, delete 

unnecessary profiles first, and then select [Temporary Profile] to recall this profile and click [Save Profile] to 

save it.

 You cannot specify [None] for the profile name.

4 The profile is saved.
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Loading profile

1 Select a profile in the [Profile] box.

The setting options in the profile are reflected on each tab.

To restore the default settings after you select the profile, click [Restore Defaults] on each tab. Selecting [None] 

on the [Profile] box will not restore them.

Deleting profile

1 Select the profile that you want to delete in the [Profile] box, and click [Delete].

The [Confirm Delete] dialog box appears.

2 Click [Yes] to delete the selected profile.
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̈ Print options

This section describes print options in each tab of the printer driver. This section will help you to find the description of 

specific print options, or understand their individual functions.

The following tabs are the setting items which depend on the OS. For their setting procedures and details, refer to the 

Operator's Manual or the Help of the OS to be used.

- [General] tab

- [Sharing] tab

- [Ports] tab

- [Advanced] tab

- [Color Management] tab

- [Security] tab

How to display:

1 Click [Start] and select [Devices and Printers].
The Printers folder appears.

 For Windows Vista or Windows Server 2008

Click [Start], [Control Panel], [Hardware and Sound] and select [Printers].

 For Windows XP or Windows Server 2003

Click [Start] and select [Printers and Faxes].

2 Select your printer, and then click [Printing preferences] in the [File] menu.
 If the [File] menu is not displayed, press [Alt].

 The printing preferences dialog box appears.

1) Printer Name

Displays the name given to the printer driver when it was installed, or the name it displays on the icon in the Printer 

folder.
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2) Menu Tabs

The menu items of the printer driver are displayed as tabs. Clicking on a tab will display the contents of the selected 

tab. The tabs displayed vary depending on the way the print properties are displayed.

- [Basic] tab

Contains basic print operation settings, such as original paper size, print paper size, paper source, paper type, 

orientation, and so on.

 P.62 “[Basic] tab”

- [Finishing] tab

Allows you to enable sort printing and N-up printing.

 P.64 “[Finishing] tab”

- [Image Quality] tab

Allows you to select how images are printed. You can easily select appropriate image quality depending on the 

type of job being printed.

 P.66 “[Image Quality] tab”

- [Effect] tab

Contains print options that add the effects to your print jobs such as Watermarks, and so on.

 P.67 “[Effect] tab”

- [Others] tab

Contains special features such as toner save, and so on.

 P.69 “[Others] tab”

- [Configuration] tab

Allows you to configure the device options of the equipment. This tab is only displayed when the printer properties 

are accessed from the Printers folder.

 P.70 “[Configuration] tab”

3) Preview window

In the Preview window, you can preview how a document will be printed under the current settings of the printer driver. 

The image of a page to which the set print options are applied is displayed.

4) Profile

Print option settings can be saved on your memory. You can save print option settings by clicking [Save Profile] and 

easily load a setting file by selecting a profile name in the box.

 P.58 “Setting print options using profiles”

5) [OK]

Enters the input settings and complete the print option settings.

6) [Cancel]

Cancels the input settings and exit the print option settings.

7) [Apply]

Enters the input settings without closing the print option settings. This button is only displayed when the printer 

properties are accessed from the Printers folder. This button remains grayed out until a setting is changed.

8) [Help]

Opens the Help for the printer driver.
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� [Basic] tab

The [Basic] tab contains basic print operation settings, such as the original paper size, print paper size, paper source, 

paper type, orientation, and so on.

1) Original Paper Size

Selects the size of a document to be printed.

 The default paper size will be [Letter] or [A4] according to the regional setting in the Windows.

 Setup items differ depending on the model.

2) Print Paper Size

Enlarges or reduces a page image to fit exactly in the selected paper size. If you do not wish to enable enlarge or 

reduce printing, select [Same as Original Size].

3) Manual Scale

Enter the scale manually to enlarge or reduce an image. The ratio can be set at between 25 and 400%.

For detailed instructions on how to print with the [Manual Scale] setting, see the following page:

 P.71 “Fitting images within paper size”

4) Paper Source

Selects a paper source to print a job in the most suitable paper size. The figure on the right indicates the paper size set 

for each paper source. When you select a paper source, the chosen one is indicated with a green square in the figure.

- Auto — Automatically selects the paper set in this equipment according to the printed document size.

- Drawer 1 — Paper is fed from the Drawer.

- Bypass Tray — Paper is fed from the Bypass Tray.

Available original paper sizes are listed below:

 A4 (210 x 297 mm)

 A5 (148 x 210 mm)

 A3 (297 x 420 mm)

 B4 (257 x 364 mm)

 B5 (182 x 257 mm)

 Folio (210 x 330 mm)

 Letter (8 1/2 x 11") 

 Legal (8 1/2 x 14") 

 Ledger (11 x 17") 

 Statement (5 1/2 x 8 1/2") 

 Computer (10 1/8 x 14") 

 13"LG (8 1/2 x 13") 

 8.5"SQ (8 1/2 x 8 1/2") 

 16K (195 x 270 mm)

 8K (270 x 390 mm)

 Env-Com10 (4 1/8 x 9 1/2")

 Env-Monarch (3 7/8 x 7 1/2")

 Envelope DL (110 x 220 mm)

 Envelope Cho-3 (120 x 235 mm)

 Envelope You-4 (105 x 235 mm)

 Env-C4 (9.02 x 12.76")

 Env-C5 (6.38 x 9.02")
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The selectable values vary depending on the devices installed in this equipment and their configuration on the 

[Configuration] tab.

5) Paper Type

Sets the media type of the paper.

- Plain — Printing on plain paper.

- Thick1 — Printing on thick 1 paper.

- Thick2 — Printing on thick 2 paper.

- Transparency — Printing on transparent sheets.

- Thin — Printing on the back side of thin paper.

 The applicable paper weight for each paper type differs depending on the model. For details of the paper 

weight, refer to the corresponding document.

 When [Drawer 1] is selected in the [Paper Source] box, only [Plain] can be chosen in the [Paper Type] box.

 When [Envelope] is selected in the [Print Paper Size] box, [Envelope] will be displayed and you cannot change 

the paper type.

 Setup items differ depending on the model.

6) Number of Copies

Sets the number of printed copies. This can be set at between 1 and 999.

7) Orientation

Sets the paper printing direction.

- Portrait — The document is printed in the portrait direction.

- Landscape — The document is printed in the landscape direction.
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� [Finishing] tab

The [Finishing] tab allows you to enable sort printing and N-up printing.

1) Copy Handling

Sets how to sort the printed sheets when numerous copies are made for printing.

- Sort Copies — Select this for sort-printing (1, 2, 3... 1, 2, 3...).

- Group Copies — Select this for group-printing (1, 1, 1... 2, 2, 2... 3, 3, 3...).

[Group Copies] can be selected only when more than 1 copy is entered at the Number of Copies option.

For the detailed instructions on how to print with the [Copy Handling] setting, see the following page:

 P.72 “Sort printing”
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2) Manual 2-Side Printing

This option enables you to select the binding position and print on both sides of paper manually. After all front sides of 

paper are printed, turn over the document and press the [START] button to print all back sides.

- None — Clear the check box if you do not want to print on both sides of paper.

- Long Edge — Select this to print on both sides of the paper with a margin on the long edge.

- Short Edge — Select this to print on both sides of the paper with a margin on the short edge.

Be sure to select the following settings on the Basic tab to use this print option:

 Any paper size other than envelopes from the “Print Paper Size” list. You cannot use envelopes.

 “Bypass Tray” from the “Paper Source” list. You need to load paper manually from the bypass tray.

 “Plain” from the “Paper Type” list. You cannot use other paper sizes.

3) Number of pages per Sheet

Sets the printing of multiple pages on one sheet. The pages are reduced to fit the selected paper size automatically 

and printed.

- 2 pages — Prints images from 2 pages arranged on one sheet.

- 4 pages — Prints images from 4 pages arranged on one sheet.

- 6 pages — Prints images from 6 pages arranged on one sheet.

- 8 pages — Prints images from 8 pages arranged on one sheet.

- 9 pages — Prints images from 9 pages arranged on one sheet.

- 16 pages — Prints images from 16 pages arranged on one sheet.

Direction of Print

Sets how the pages are arranged on one sheet.

- Left to Right — Arranges pages horizontally from the left and printed top to bottom on one sheet.

- Right to Left — Arranges pages horizontally from the right and printed top to bottom on one sheet.

- Left to Right by column — Arranges pages vertically from the top and printed left to right on one sheet.

- Right to Left by column — Arranges pages vertically from the top and printed right to left on one sheet.

Draw Borders Around Pages

Prints borders around each page.

For the detailed instructions on how to print with the [Number of pages per Sheet] setting, see the following page:

 P.74 “Printing several pages on one sheet”

Portrait Landscape
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4) Use Custom Margin

This option enables you to set the custom margins. You usually set margins in your application. If you cannot set them 

in the application, use this option. Select the check box and click “Details” to open the dialog box. Select “Units”, set 

the right, left, top, and bottom margins, and then click [OK] to enable them.

- Margin — Enter the value from 4.2 mm to 100 mm/ 0.17 inches to 3.94 inches.

- Units — Select the unit, “inch” or “mm”, for values.

- Restore Defaults — Click this button to restore the margins to the default settings.

If the application has the function to set margins, be sure to set them in the application.

� [Image Quality] tab

The [Image Quality] tab allows you to select how images are printed. You can easily select the appropriate image quality 

depending on the type of document.

1) Smoothing

Prints texts and graphics smoothly.

2) Distinguish Thin Lines

Select this check box to print thin lines clearly.

3) Use Black for All Text

Prints all texts in 100% black except white texts.

1

2

3



3.PRINT FUNCTIONS

Setting Up Print Options    67

3 PRINT FUNCTIONS

� [Effect] tab

The [Effect] tab contains print options that add effects to your print jobs such as Watermarks and Rotate printing.

1) Watermark

Selects the watermark to be used or edited. The following values except [None] are the default watermarks that have 

been registered in the printer driver. Up to 20 new watermarks can be added in this box.

- None — Select this if no watermark is desired.

The following default watermarks are also displayed in the box:

- TOP SECRET

- CONFIDENTIAL

- DRAFT

- ORIGINAL

- COPY

For the detailed instructions on how to print with the [Watermark] setting, see the following page:

 P.75 “Printing with watermarks”

[Add]

Creates a new watermark. The [Watermark] dialog box appears when you click on this.

 P.68 “Add/Edit Watermark”

[Edit]

Select a watermark from the [Watermark] box and click it to edit the watermark. The [Watermark] dialog box appears 

when you click on this.

 P.68 “Add/Edit Watermark”

[Delete]

Select a watermark from the [Watermark] box and click it to delete a watermark.

 P.77 “Deleting a watermark”

 The default watermarks can be deleted but, once deleted, they cannot be restored.

 [None] cannot be deleted.

Print on First Page Only

Prints a watermark on the first page only. This setting will become available when any watermark is selected from the 

[Watermark] box.

2) Rotate 180 Degrees

Performs rotation printing of an image.
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Add/Edit Watermark

When you click [Add] or [Edit], the [Watermark] dialog box appears and you can create new watermark or edit selected 

watermarks.

1) X Position

The horizontal position of the watermark is displayed. You can change the position using the horizontal scroll bar.

2) Y Position

The vertical position of the watermark is displayed. You can change the position using the vertical scroll bar.

3) Units

Select the unit for the “X Position” and “Y Position” field.

4) [Center Watermark]

Click this to automatically move the watermark position to the center.

5) Caption

Enter the text of a watermark. You can enter up to 63 characters. 

When you are editing a watermark, the selected watermark text is displayed in the box.

The entered text is displayed as the sample image on the left.

6) Font Name

Select the font to be used for the watermark text.

7) Style

Select the font style for the watermark text.

- Regular — Sets the regular style to the text.

- Bold — Sets the bold style to the text.

- Italic — Sets the italic style to the text.

- Bold Italic — Sets the bold and italic style to the text.

8) Font Size

Enter the font size for the watermark text. The font size can be set from 6 to 300 pt in units of 1 pt.

9) Angle

Enter the degree of angle for rotating the watermark text. The angle can be set from -90 to 90 degrees in units of 1 

degree. You can also set the degree of the angle by moving the scroll bar.

10) Solid

Prints a solid type of watermark.

11) Draw as Outline

Prints a outline type of watermark.

12) Transparency

Prints a transparent watermark. When you select this, set the brightness from 0 (darker) to 100% (lighter) in units of 

1%. You can also set the brightness using the scroll bar.

13) [Restore Defaults]

Restores the settings displayed in the [Watermark] dialog box to the original factory defaults.
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� [Others] tab

The [Others] tab contains print options such as toner saving, and so on.

1) Default Menu Setting

Select the default tab that is displayed when you open the printing preferences of the printer driver. Set frequently used 

functions as a default menu setting for your convenience.

If you made settings on the [Others] tab menu from the print setting page of the application, they are restored to the 

defaults when you close the printer driver.

If you want to resume the settings, set the printer driver from the [Devices and Printers] folder.

 P.57 “Setting initial values of print options”

2) Toner Save

Prints in the toner save mode.

When the toner save mode is enabled, printing may become lighter.

3) Do not Print Blank Pages

Select this check box to ignore blank pages for printing.

 If the watermark option is enabled, all pages are printed even when the content is blank.

 If the blank pages have a header or footer, they are printed.

4) Version Information

Click this button to show the version of the printer driver.

5) Restore All Defaults

Click this button to restore all print options to the default settings.

Click [OK] on the confirmation dialog box to start restoring or [Cancel] to stop it.
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� [Configuration] tab

The [Configuration] tab allows you to configure options. When any optional unit is installed in this equipment, set the 

configuration of the machine on this tab. The [Configuration] tab can be displayed only from the Printers folder (and not 

when displaying the properties from the application’s print dialog box).

In order to set the [Configuration] tab, you must access the printer driver properties from the [Devices and Printers] 

folder (Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server 2003: [Printers and Faxes]). 

For detailed instructions on how to set the [Configuration] tab, see the following page:

 P.50 “Configuring options manually”

1) [Drawer Settings]

Sets the paper size and paper type of each drawer. The [Drawer Settings] dialog box appears by clicking this.

 P.70 “Drawer Settings”

2) [Version Information]

Displays the [Version Information] dialog box.

Drawer Settings

1) Paper Size

Select the paper size set in each drawer.

2) Paper Type

Select the paper type set in each drawer.

3) [Restore Defaults]

Restores the configuration of this equipment displayed in the [Configuration] tab menu to the original factory defaults.
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In this section, procedures are given to print various types of print jobs, using the layout and finishing options. Read this 

section before starting printing and select the procedure best suited for your needs.

 P.71 “Layout and finishing options in [Basic] tab menu”

 P.72 “Layout and finishing options in [Finishing] tab menu”

 P.75 “Finishing options in [Effect] tab menu”

̈ Layout and finishing options in [Basic] tab menu

Using the printer driver, you can set various layout options to suit your preferences. In this section various printing 

functions enabled with the [Basic] tab menu are explained.

 P.71 “Fitting images within paper size”

� Fitting images within paper size

Automatically enlarges or reduces an image to fit into a specified paper size, or manually set the scale to enlarge or 

reduce it.

Printing enlarged or reduced image to fit the specified paper size

1 Display the [Basic] tab menu.

2 Select the document size on the [Original Paper Size] box. Then select the paper size 

that you want to print at the [Print Paper Size] box.

The document image is automatically enlarged or reduced depending on the original paper size and print paper 

size.

3 Set any other print options and click [OK].

4 Click [OK] or [Print] to send the print job.

Printing an enlarged or reduced image by specifying the scale manually

1 Display the [Basic] tab menu.

2 Check the [Manual Scale] box. Then enter the scale.

The scale can be set from 25% to 400% in units of 1%.

3 Set any other print options and click [OK].

4 Click [OK] or [Print] to send the print job.
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̈ Layout and finishing options in [Finishing] tab menu

Using the printer driver, you can set various layout options to suit your preferences. In this section various printing 

functions enabled with the [Finishing] tab menu are explained.

 P.72 “Sort printing”

 P.74 “Printing several pages on one sheet”

� Sort printing

Selects how multiple copies of a document to be output, such as separately for each copy and grouping each page.

Sorting printed documents according to the copies

1 Display the [Basic] tab menu.

2  Enter the number of copies to be printed at the [Number of Copies] box.

3 Display the [Finishing] tab menu.

4 Select [Sort Copies] icon at [Copy Handling].

5 Set any other print options and click [OK].

6 Click [OK] or [Print] to send the print job.

Sorting printed documents according to the pages

For example, assume that you have a three-page job (A, B, C) and you want three copies of each page in this order (AAA, 

BBB, CCC).

1 Display the [Basic] tab menu.

2 Enter the number of copies to be printed at the [Number of Copies] box.

3 Display the [Finishing] tab menu.

4 Select [Group Copies] icon at [Copy Handling].

5 Set any other print options and click [OK].

6 Click [OK] or [Print] to send the print job.
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� Printing on both sides of paper

You can print on both sides of paper. Be sure to load the paper, which you specify at step 1, on the bypass tray in advance.

1 Open the [Basic] tab to select the following settings.
 Any paper size other than envelopes from the Print Paper Size list. You cannot use envelopes.

 “Bypass Tray” from the Paper Source list. You need to load paper manually from the bypass tray.

 “Plain” from the Paper Type list. You cannot use other paper sizes.

2 Open the [Finishing] tab, select the [Manual 2-Side Printing] check box, and select the 

binding position icon.

Long Edge — Select this to print on both sides of the paper with a margin on the long edge.

Short Edge — Select this to print on both sides of the paper with a margin on the short edge.

3 Set other necessary print options and click [OK].

4 Click [OK] or [Print] to start the print job.
After all front sides of paper are printed, turn over the document and press the [START] button to print all back 

sides. After printing, you can bind the document at the specified position.
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� Printing several pages on one sheet

Prints several pages of a document on one sheet of paper (N-up feature). This feature is very useful for browsing a large 

number of pages for appearance or page order.

For example, to check the navigation path of a number of web pages or review the narrative of a slide presentation, using 

N-up is not only convenient but conserves paper as well.

Printing multiple pages per sheet

1 Display the [Finishing] tab menu.

2 Select how many pages you want to print on a single sheet at the [Number of pages per 

Sheet] box.

2 pages — Prints images from 2 pages arranged on one sheet.

4 pages — Prints images from 4 pages arranged on one sheet.

6 pages — Prints images from 6 pages arranged on one sheet.

8 pages — Prints images from 8 pages arranged on one sheet.

9 pages — Prints images from 9 pages arranged on one sheet.

16 pages — Prints images from 16 pages arranged on one sheet.

3 Select how the pages are arranged on one sheet in the [Direction of Print] option.

Left to Right — Arranges pages horizontally from the left and printed top to bottom on one sheet.

Right to Left — Arranges pages horizontally from the right and printed top to bottom on one sheet.

Left to Right by column — Arranges pages vertically from the top and printed left to right on one sheet.

Right to Left by column — Arranges pages vertically from the top and printed right to left on one sheet.

Items that can be selected in [Direction of Print] may vary depending on the number of pages selected at the 

[Number of pages per Sheet] box.

4 If you want to draw a line around each page, select the [Draw Borders Around Pages] 

check box.

5 Set any other print options and click [OK].

6 Click [OK] or [Print] to send the print job.
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̈ Finishing options in [Effect] tab menu

Using the printer driver, you can set various layout options to suit your preferences. In this section various printing 

functions enabled with the [Effect] tab menu are explained.

 P.75 “Printing with watermarks”

� Printing with watermarks

Watermarks overprint your document with useful information, such as [TOP SECRET], [CONFIDENTIAL], [DRAFT], 

[ORIGINAL], or [COPY]. You can choose from several predefined watermarks or you can create and save your own 

custom watermarks.

Watermarks are text only. 

Printing a watermark

1 Display the [Effect] tab menu.

2 Select the watermark to be printed at the [Watermark] box.

You can create a new watermark if there is none you want to apply on the box.

 P.76 “Creating or editing a watermark”

3 If you want to print the watermark on only the first page, select the [Print on First Page 

Only] check box.

4 Set any other print options and click [OK].

5 Click [OK] or [Print] to send the print job.
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Creating or editing a watermark

1 Click [Add] to create a new watermark, or select one that you want to edit and click 

[Edit] to edit a watermark.

The [Watermark] dialog box appears.

2 Enter the watermark text in the [Caption] box.
You can enter up to 63 characters for the [Caption] box. However, if too many characters are entered, the 

watermark may not be printed correctly.

3 Select a font for the watermark at the [Font Name] box.

4 Select a font style for the watermark at the [Style] box.

5 Enter the font size in the [Font Size] box.
You can enter any integer between 6 and 300pt in units of 1pt.

6 To rotate the watermark, enter the number of degrees in the [Angle] box.
 You can enter from -90 degrees to 90 degrees in units of 1 degree in the [Angle] box.

 You can also set the angle using the scroll bar.

7 Select how the watermark text is printed from [Solid], [Draw as Outline], and 

[Transparency].
Solid — Prints a solid type of watermark.

Draw as Outline — Prints an outline type of watermark.

Transparency — Prints a transparent watermark. Set the transparent ratio from 0 to 100% in units of 1%. You can 

also set the transparent ratio using the scroll bar.

8 Enter the X and Y values or move the scroll bar to adjust the watermark position.
 You can adjust the position horizontally with “X” and vertically with “Y”.

 You can select the unit, [inches] or [mm].

 Click [Center Watermark] to locate the watermark text to the middle horizontally and vertically.

9 Click [OK] to save the watermark settings.
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Deleting a watermark

You can delete the default watermarks. However, they cannot be restored by clicking [Restore Defaults].

1 Select the watermark that you want to delete at the [Watermark] box.

2 Click [Delete].
The [Confirm Delete] dialog box appears.

3 Click [Yes].
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Scanning From Application

This equipment supports scanning from TWAIN-compatible applications. TWAIN is the standard that links applications and 

scanners that acquire images. For TWAIN support, see your application’s manual.

Before you start scanning with this equipment, make sure that you have installed the scanner driver. For details, refer to 

the Software Installation Guide.

The default original size depends on the measurement system on Windows: A4 for Metric or LT for U.S.. You can 

change the default only before the first execution after installation. For the measurement system, see the Windows 

Help.

̈How to scan

Follow the steps below to scan the original.

1 Place the original(s).
 P.27 “Placing originals on the original glass”

 P.28 “Placing originals on the Automatic Document Feeder”

2 Run your TWAIN-compatible application and execute the image acquisition command.
You can usually execute the scan or image acquisition command on the [File] menu to select this equipment. The 

location of the command and the method to select the scanner vary depending on the application. See your 

application’s manual.

3 Set the scan settings.
 You can make various options to scan the original image.

 P.81 “Scan options”

 You can also make the scan settings using the Easy Set feature.

 P.83 “Using the Easy Set feature”

4 Click [Pre-Scan] to preview the original.
If you are not satisfied with the preview image, change the scan settings and preview the image again.

5 Click [Scan] to scan the original.
While scanning, you can stop scanning by clicking [CANCEL].

6 Save the scanned image in your application.
The saving command varies depending on the application. You usually execute the Save or Save as command on 

the File menu. If necessary, modify the scanned image, using the various graphic commands in your application.
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Setting Up Scan Options

You can make various options to affect the scanning status. You can save different sets of options in files and recall one of 

them for frequent use.

̈ Scan options

The basic and advanced dialogs are available for the scan operation.

�Basic scan dialog

When you execute the image acquisition command, the following basic scan dialog appears.

1) Easy Set

The scan options can be saved.

 P.83 “Using the Easy Set feature”

2)

Clears the preview image.

3) Preview screen

The pre-scanned image appears. The dotted boundary shows the scanning area or the original size. The image 

information appears under the preview screen.

4)

Shows the version information of the scanner driver.

5)

Shows the Help information about this scanner driver.

6) [Close]

Quits the scanning operation.

7) [Pre-Scan]

Pre-scans the original.

8) [Scan]

Scans the original. 

9) Measurement unit

Select [Inch], [mm], or [Pixel] to change the measurement unit.

10)

Opens the advanced scan dialog.

 P.82 “Advanced scan dialog”

1

2

4

5

6 7 8

3

9

10
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�Advanced scan dialog

You can click the triangle that faces right on the right-hand side of the basic scan dialog box to make scanning settings. 

The default settings are underlined.

1) Resolution

Sets the horizontal and vertical resolution as dots per inch: 150 x 150 dpi, 300 x 300 dpi, or 600 x 600 dpi.

2) Original Mode

Sets the original mode to fit the original image such as text only or the mixture of text and photos: Text, Text/Photo, 

Gray, or Color.

3) Original Size

Sets the original document size or the scanning area.

Select the original size from the pull-down list.

The displayed items differ depending on the installed options and destinations.

4) ADF/Platen

Selects the equipment on which the originals are placed: Platen Scan, ADF Scan, or Duplex Scan.

The displayed items differ depending on the installed options and destinations.

5) Rotation

Rotates the imaged clockwise by 90 degrees, counterclockwise by 90 degrees, or by 180 degrees. This option takes 

effect on the image to scan but not on the preview image: OFF, Right 90, Left 90, or 180.

6)

Closes the advanced scan dialog and return to the basic scan dialog.

 P.81 “Basic scan dialog”

7) [Enhanced Settings] tab

-  Exposure/Contrast

Adjusts the exposure and contrast of the image using the scroll bar or editing the field: -100 (darker) to 100% 

(lighter).

[Contrast] is only available when [Gray] or [Color] is selected in [Original Mode].

-  Sharp

Adjusts the sharpness of the image using the scroll bar or editing the field: -2 (softer) to 3% (sharper).

[Sharp] is only available when [Gray] or [Color] is selected in [Original Mode].

-  RGB Adjustment

Adjusts the RGB values of the image using the scroll bar or editing the field: -100 to 100%.

[RGB Adjustment] is only available when [Color] is selected in [Original Mode].

-  Saturation

Adjusts the saturation of the image using the scroll bar or editing the field: -100 to 100%.

[Saturation] is only available when [Color] is selected in [Original Mode].

1

2
3

5

7

6

8

4
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8) Default

Resets all the settings back to the defaults.

̈Using the Easy Set feature

When you have made scan settings, you can save them as an Easy Set file. This allows you to load a specific batch of 

settings without changing the scan settings each time.

� Saving the Easy Set file

You can save multiple Easy Set files.

1 Open the advanced scan dialog from within your application.
 P.80 “How to scan”

2 Set the scan options as you like.
 P.81 “Scan options”

3 Click  next to the Easy Set menu.

4 Enter a file name, select a folder where you save the file, and then click [Save].

�Using the Easy Set file

1 Select the pre-defined Easy Set file, or click  next to the Easy Set menu to select your 

Easy Set file.
 The following two pre-defined files are available.

 When the Open dialog box appears, select the folder, select the target Easy Set file, and then click [Open].

2 Click [Pre-Scan].

�Deleting the Easy Set files

You can delete the Easy Set files in the same way as for normal files. Locate the folder where you have saved the Easy 

Set file, right-click the file, and then click [Delete] from the menu. Click [Yes] to delete the file. When you are working in the 

preview window, click the folder icon next to the Easy Set menu so that you can delete the file in the same way. After 

deleting the file, click [CANCEL] to close the dialog box.

Pre-defined File Resolution Original Mode Other Scan Options

Picture 150 x 150dpi Text/Photo Default settings

Text 600 x 600 dpi Text
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Copy Menu List

See the following pages for information on using the copy menu.

 P.25 “COPY FUNCTIONS”

̈Copy menu items

When you press  or  on the main screen (Copy), you enter the copy menu which allows you to use copy functions.

The table below shows the functions and reference pages available in the copy menu.

Menu Functions Settings Description and Reference Pages

EXPOSURE AUTO, Manual (9 steps) Sets the density level for the copied image.

 P.33 “Adjusting the exposure”

ORIGINAL MODE TEXT/PHOTO, TEXT, PHOTO, 

BACKGROUND ERASE

Sets an original mode suitable for the 

image being copied.

 P.34 “Selecting the original mode”

DRAWER Drawer 1 XX, Bypass XX, APS Sets the paper source.

 P.35 “Selecting the paper”

ZOOM Manual zoom (25 - 100 - 400%), 

FIXED ZOOM, AMS

Sets the zoom ratio for copied images.

 P.37 “Enlarging or reducing the copy 

size”

FINISHING NON SORT, SORT Sets the finishing mode for ejecting copies.

 P.40 “Sorting pages”

2IN1/4IN1 OFF, 2IN1, 4IN1 Copies two or four originals onto one sheet 

of paper.

 P.41 “Copying two or four pages on 

each sheet”

ID CARD OFF, ON Sets the ID card function.

 P.43 “Copying both sides of a card on a 

sheet”

EDGE ERASE OFF, ON (4 - 15mm) Sets the edge erase function.

 P.44 “Erasing the shadow on edges”

IMAGE SHIFT OFF, LEFT MARGIN, RIGHT MARGIN Sets the image shift function.

 P.45 “Shifting the pages to the right or 

left”

ANNOTATION OFF, PAGE NO. Sets the annotation function.

 P.46 “Adding a page number on the 

copied paper”
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User Functions Menu List

Before you start operating the “USER FUNCTIONS” menu, learn the general procedure below.

 Press [CANCEL] to exit from the setting without making any changes. You can also exit with the  button if it is 

active.

 Press [CLEAR/STOP] to delete a character. Keep pressing [CLEAR/STOP] for a second to clear all characters.

1 Press [USER FUNCTIONS].

2 Press  or  to scroll the menu, and then press  to enter the function menu.
 P.88 “User functions menu items”

3 Press  or  to scroll the menu, and then press  to select the function.

4 Press  or  to scroll the menu, and then press  to select the settings for each 

function.

5 Press , , , or  to select a setting, and then press [OK].
 Repeat this step if the selected setting has more options or values.

 Exits from the menu if the selected setting has no more options or values. At this point, the operation is 

complete.

The options or values vary depending on the function.

 P.88 “GENERAL”

 P.89 “COPY”

 P.89 “PRINTER”

 P.89 “DRAWER”

 P.90 “INFORMATION”

USER FUNCTIONS

GENERAL

COPY

PRINTER
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̈User functions menu items

When you press [USER FUNCTIONS] on the main screen (Copy), you enter the “USER FUNCTIONS” menu which 

enables you to change each setting and execute the device functions.

The table below shows the functions and reference pages available in the “USER FUNCTIONS” menu.

�GENERAL

The following functions and settings are available on the “GENERAL” menu.

Menu Functions Reference Pages

GENERAL CHANGE LANGUAGE  P.88 “GENERAL”

TIMERS AUTO POWER SAVE

SLEEP MODE

AUTO CLEAR

POP UP DRAWER SET

PAPER JAM RECOVERY

LCD CONTRAST

COPY EXPOSURE  P.89 “COPY”

ORIGINAL MODE

MAXIMUM COPIES

SORT MODE PRIORITY

IMAGE ROTATION

2IN1/4IN1 ORIGINAL SIZE

ORIG. ORIENTATION

PAGE LAYOUT

BACKGROUND

SHARPNESS

PRINTER AUTO DRAWER CHANGE  P.89 “PRINTER”

DRAWER DRAWER 1 PAPER SIZE  P.89 “DRAWER”

INFORMATION COUNTER TOTAL COUNTER  P.90 “INFORMATION”

TONER REMAIN

Menu Functions Settings Description

CHANGE LANGUAGE S-CHINESE (SIMPLIFIED CHINESE), 

T-CHINESE (TRADITIONAL CHINESE), 

ENGLISH, FRENCH, ITALIAN, GERMAN, 

POLISH, RUSSIAN, SPANISH, SWEDISH, 

NORWEGIAN, FINNISH, DANISH, DUTCH, 

PORTUGUESE, CZECH, HUNGARIAN, 

ROMANIAN, SLOVAKIAN, LITHUANIAN, 

IRISH, SLOVENIAN, BULGARIAN, 

LATVIAN, SERBIAN, TURKISH

Sets the default language. The default 

language and the appearance order vary 

depending on the region.

TIMERS AUTO POWER 

SAVE

1, 3, 4, 5, 7, 10, 15, 20, 30, 45, 60 Sets the period of time (in minutes) that this 

equipment should wait before low power mode 

is activated.

SLEEP MODE 1, 3, 5, 10, 15, 20, 25, 30, 40, 50, 60 Sets the period of time (in minutes) that this 

equipment should wait before sleep mode is 

activated.

AUTO CLEAR 15, 30, 45, 60, 75, 90, 105, 120, 135, 150 Sets the time (in seconds) to clear the previous 

settings and return to the main screen (Copy).

POP UP DRAWER SET ENABLE, DISABLE Sets whether to display a pop-up message on 

the LCD screen in the following cases.

 When the size of paper loaded in the 

drawer differs from setting.

 When a paper misfeed occurs.

PAPER JAM 

RECOVERY

ENABLE, DISABLE

LCD CONTRAST -3 (Light) to +3 (Dark) Sets the brightness of LCD panel.
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�COPY

The following functions and settings are available on the “COPY” menu.

� PRINTER

The following functions and settings are available on the “PRINTER” menu.

�DRAWER

The following functions and settings are available on the “DRAWER” menu.

Menu Functions Settings Description

EXPOSURE AUTO, Manual Sets the default setting for the density.

ORIGINAL MODE TEXT/PHOTO, TEXT, PHOTO,

BACKGROUND ERASE

Sets the default setting for the original mode.

MAXIMUM COPIES 9, 99, 999 Sets the maximum number of copies to be 

allowed.

SORT MODE PRIORITY NON SORT, SORT Sets the default sort mode for copy jobs.

IMAGE ROTATION ENABLE, DISABLE Sets the image rotation setting.

When this setting is enabled, the original 

image is automatically rotated when 

making copies. As shown in the following 

figure, when you copy A4 size originals to 

the one side of the A3 size paper loaded 

on the bypass tray, disable this function.

Original: A4  Paper: A3

2IN1/4IN1 ORIGINAL SIZE A4, A5, 16K, B5, LT, ST, 8.5SQ Sets the default setting for the original size 

when using the “2IN1/4IN1” function.

ORIG. 

ORIENTATION

- Sets the default setting for the original 

orientation when using the “2IN1/4IN1” 

function.

PAGE LAYOUT 2IN1: Sets the order of the pages when using the 

“2IN1/4IN1” function.

4IN1: 

BACKGROUND Adjusts the density of the original’s 

background. It avoids the back side of a 2-

sided original becoming visible on its front 

side. You can change the background from 

lighter to darker in nine steps from -4 to +4.

SHARPNESS Emphasizes or blurs the outline of the image. 

You can change the sharpness from softer to 

sharper in nine steps from -4 to +4.

Menu Functions Settings Description

AUTO DRAWER CHANGE SAME DIRECTION, DIFFERENT 

DIRECTION, OFF

Sets whether to change to a different drawer 

when the specified drawer becomes empty.

Menu Functions Settings Description

DRAWER 1 PAPER SIZE A4, LT, 16K Sets the paper size for the drawer.

A4 A3

ENABLE

DISABLE

A4

A
4
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� INFORMATION

The following functions and settings are available on the “INFORMATION” menu.

Menu Functions Settings Description

COUNTER TOTAL COUNTER - Displays the total counter.

TONER REMAIN - Displays the toner remaining information.
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When This Message Appears

A message appears when a problem occurs on the equipment. Find the message on the list below and follow the 

instructions in the Countermeasure.

Message Meaning Countermeasure

MISFEED xxx An original or a sheet of copy paper is 

misfed. An error code “xxx” and a 

message for solving the problem are 

displayed.

Remove any misfed paper.

 P.93 “Paper Misfeed”

CLOSE *** Any cover of the equipment indicated 

by “***” is not securely closed.

Close the cover securely.

DRAWER * EMPTY The paper in a drawer indicated by “*” 

has run out.

Load paper in the drawer.

 P.17 “Loading paper in the drawer”

COUNT OVER The number of pages scanned has 

exceeded the maximum value.

Select “PRINT” on the LCD screen to copy the data scanned 

so far. Select “CANCEL JOB” to delete all the data scanned so 

far.

CALL FOR SERVICE The repair or adjustment by your 

service technician is needed.

Contact your service representative.

Give the service technician the error code (consisting of 

letters and numbers) that appears in the upper right area of 

the LCD screen.

Never attempt to repair, disassemble or modify the 

equipment by yourself.

This could cause an electric shock, a fire or serious injury. 

Contact your service representative when the equipment is in 

an abnormal condition or any malfunction is found.

TIME FOR MAINTENANCE The maintenance by your service 

technician is needed.

Contact your service representative.

BYPASS EMPTY Paper set on the bypass tray has run 

out.

Load paper on the bypass tray.

 P.19 “Loading paper on the bypass tray”

TONER IS LOW There is only a little toner remaining in 

the toner cartridge.

There is still a little toner remaining in the toner cartridge. Do 

not replace the toner cartridge until “TONER EMPTY” appears 

on the LCD screen.

 The message may not appear because the toner 

remaining in the cartridge does not lie evenly.

 When the message appears, it is advisable to 

purchase a new recommended cartridge to prepare 

for its replacement.

ERROR : TONER The toner cartridge is not installed 

correctly.

Install the toner cartridge correctly.

The recommended toner cartridge is 

not being used.

If you are using a toner cartridge other than the one we 

recommend, the equipment may not be able to detect whether 

it is installed or not. For details of the recommended toner 

cartridge, refer to the Safety Information.

TONER EMPTY The toner in the toner cartridge has 

run out.

Replace the toner cartridge with a new one. 

 P.98 “Replacing Toner Cartridge”

MEMORY IS FULL The built-in memory of the equipment 

has become full.

Select “PRINT” on the LCD screen to copy the data scanned 

so far. Select “CANCEL JOB” to delete all the data scanned so 

far.

CLEAR PAPER OUTPUT 

TRAY:

PRESS START KEY

Approx. maximum sheets of paper 

have continuously exited and the 

equipment stops copying to prevent 

the copied paper from overflowing 

from the tray.

Remove the paper from the receiving tray, and then press 

[START] to resume copying.

Press [CLEAR/STOP] to end the copy. When “MEMORY 

CLEAR?” appears on the LCD screen, select “YES”, and then 

press [START].
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Paper Misfeed

̈ Find the position of paper misfeeds

When a paper misfeed occurs in the equipment, the operation stops, the alert lamp blinks on the control panel, and a 

message appears on the LCD screen to indicate the positions where the paper is misfed.

Press  and [OK] to select [Help]. Check the message, remove any misfed paper, and then press [START] to resume 

copying.

 P.87 “User Functions Menu List”

When a paper misfeed occurs in the equipment, the instruction to remove the misfed paper appears on the LCD 

screen. Press  and  to scroll up and down to read the instruction.

̈When paper misfeeds occur frequently

When paper misfeeds occur frequently, they may be due to one of the causes listed below:

 Unacceptable paper is used.

 P.16 “Paper types not acceptable”

 The sizes of paper loaded in the drawer or on the bypass tray are not registered into the equipment properly.

 P.24 “Preparation 3 - Registering Paper Size and Type”

 More misfed paper is still remaining after the release of a paper misfeed.

 The side guides are aligned too tight or too loose to the paper.

 The height of the stacked paper is exceeding the indicators in the drawer.

̈When removing misfed paper

Observe the following precautions when you remove misfed paper:

Do not tear misfed paper.

Remove misfed paper carefully with both hands. Do not pull the paper forcefully, otherwise the paper could tear and cause 

a paper misfeed. Make sure there are no torn pieces of paper left in the printer.

Do not touch the fuser unit or the metal part around the unit.

When you remove misfed paper within the fuser unit, do not touch the fuser unit or the metal part around the unit. If you 

touch the inside of the equipment, this could cause burns or any injury to your hands.

Do not touch the photoconductive drum.

When you remove the misfed paper within the transfer unit or the fuser unit, be careful not to touch the photoconductive 

drum. This could stain the copy images.
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̈ Paper misfeeds on the Automatic Document Feeder (ADF)

1  Open the upper cover.

2  Open the transport guide and remove the original.

3  Open the ADF.

4  Turn the dial to remove the misfed original.
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5  Close the ADF.

6  Raise the feeder tray.

7  Turn the dial to remove the misfed original.

8  Lower the feeder tray.

9  Close the upper cover.

̈ Paper misfeeds on the bypass tray

1 Release the lever on the left, and then pull out the misfed paper on the bypass tray.

2 Check beneath the transport guide in the paper feeding area.
Check if any paper is misfed under the transport guide behind the transfer unit.

 P.96 “Paper misfeeds inside of the side cover”

1

2
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̈ Paper misfeeds inside of the side cover

 Be careful not to catch your fingers between the equipment and the side cover. 

This could injure you.

 Do not touch the fuser unit or the metal part around the unit.

If you touch the inside of the equipment, this could cause burns or any injury to your hands.

1 Open the side cover.

2 Remove the misfed paper behind transfer unit.

Be sure not to touch the photoconductive drum when removing the misfed paper.

3 If you cannot see the misfed paper or it is difficult to remove, open the drawer and 

remove it.

Be sure that the height of the stacked paper does not exceed the line indicated inside of the side guides.

4 Close the drawer.

2

1
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5 Lay down the transfer unit, and then press down the two fuser pressure release levers 

(green) until they come to a stop.

Press down the levers fully until they stop.

6 Raise the transport guide.

7 Release the misfed paper within the fuser unit.
Pull the misfed paper up or down as shown below depending on its position.

Be sure not to touch the photoconductive drum when releasing the misfed paper.

8 Return the transport guide and transfer unit to their original positions, and then close 

the side cover.

Pulling it up Pulling it down
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Replacing Toner Cartridge

̈When a message for replacement appears

When the toner cartridge runs out of toner, the message appears on the LCD screen and the alert lamp blinks on the 

control panel.

When  is pressed, the procedure to replace the toner cartridge appears on the LCD screen. Press  and  to scroll 

up and down to read the procedure.

Never attempt to incinerate toner cartridges.

Dispose of used toner cartridges and waste toner boxes in accordance with local regulations.

 Before inserting a new toner cartridge, check that the product name is “T-2505”.

 Do not touch the parts on the circuit board mounted on the toner cartridge because they may be damaged.

1 Open the front cover.

2 While holding down the green lever, pull out the toner cartridge.

Never attempt to incinerate toner cartridges.

Dispose of used toner cartridges in accordance with local regulations.
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3 Shake the new toner cartridge strongly with the label surface down to loosen the toner 

inside.

4 Pull out the seal in the direction of the arrow.

5 Insert the toner cartridge along the rail.

Insert the toner cartridge until you hear a click sound.

101010
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6 Clean the charger.
Hold the cleaning knob of the charger and pull it out toward you carefully until it stops. Then reinsert it in its original 

position carefully. Repeat this procedure two to three times.

Check if the cleaning knob is fully inserted after cleaning.

7 Close the front cover.
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Before Calling Service Technician

When you encounter troubles, find the symptom listed below and follow the instructions in the Countermeasure.

̈General operation

̈ Toner-related items

̈Original/Paper-related items

Phenomenon Usual cause Countermeasure

The equipment does not work at 

all.

The power is not turned ON. Turn ON the power of the equipment.

The power cable is not plugged in 

securely.

Plug in the power cable securely.

The button does not respond to 

my operation.

It has been a short time since the 

power was turned ON.

Wait for the completion of warm-up and then try again.

The LCD screen is too light/dark. The contrast of the LCD screen is 

not adjusted properly.

Adjust the contrast.

 P.87 “User Functions Menu List”

A message is displayed on the 

LCD screen.

The equipment has detected an 

error status.

See the meaning of the message referring to the listing below.

 P.92 “When This Message Appears”

“SAVING ENERGY” appears on 

the LCD screen.

The equipment is in the low 

power mode.

Press any button on the control panel to cancel this mode. 

Copying is enabled in the low power mode.

 P.13 “Saving energy when not in use - Energy saving 

mode -”

The LCD screen is dim. The equipment is in the sleep 

mode.

Press any button on the control panel to cancel this mode.

 P.13 “Saving energy when not in use - Energy saving 

mode -”

Copy functions cannot be set. Some copy functions that cannot 

be set simultaneously with others 

have been set.

Some copy functions cannot be set together with others.

 P.110 “Copying Function Combination Matrix”

The equipment is not recognized 

when it is connected to a PC 

using a USB cable.

The cable is not support the 

USB2.0 Hi-Speed. 

Use a USB2.0 Hi-Speed certified cable.

The equipment is connected via a 

USB hub.

Connect the equipment with a PC directly by a USB cable.

Phenomenon Usual cause Countermeasure

“TONER IS LOW” appears on the 

LCD screen.

Toner is running out. There is still a little toner remaining in the toner cartridge. Do 

not replace the toner cartridge until “TONER EMPTY” appears 

on the LCD screen.

“TONER EMPTY” appears on the 

LCD screen.

Toner has run out. Replace the toner cartridge with a new one.

“ERROR : TONER” appears on 

the LCD screen.

The toner cartridge is not 

installed, or it is installed 

incorrectly.

Install the toner cartridge correctly.

The recommended toner 

cartridge is not being used.

If you are using a toner cartridge other than the one we 

recommend, the equipment may not be able to detect whether 

it is installed or not. For details of the recommended toner 

cartridge, refer to the Safety Information.

“TONER IS LOW” does not 

appear on the LCD screen, 

although toner is nearly empty.

The recommended toner 

cartridge is not being used.

For details of the recommended toner cartridge, refer to the 

Safety Information.

The equipment does not become 

ready after the toner cartridge is 

inserted.

The toner cartridge inserted is not 

usable for this equipment.

Check that the product name is “T-2505”.

Phenomenon Usual cause Countermeasure

Paper misfeeds. The paper is unsuited for the 

equipment.

Check if the paper is acceptable.

 P.16 “Paper types not acceptable”

The paper size is not registered 

properly in the equipment. 

Register the paper size properly. 

 P.24 “Preparation 3 - Registering Paper Size and Type”

Misfed paper is located in a place 

you cannot see easily.

See the message on the LCD screen to recheck the position 

where the paper misfeed has occurred.

 P.93 “Paper Misfeed”

There is no gap between the side 

guides and paper in the drawer, 

or the gap is too wide.

Adjust the gap between the side guides and the paper 

properly.

 P.17 “Loading paper in the drawer”

Multiple feeding occurs. Sheets of paper clinging to each 

other.

Fan the paper well and place it again.
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̈ Image trouble

Phenomenon Usual cause Countermeasure

The copy image is light. Toner has run out. Replace the toner cartridge if the “TONER EMPTY” message 

appears on the LCD screen.

 P.98 “Replacing Toner Cartridge”

The copy density is set lighter. Make the density darker if you use the manual copy density 

mode.

The copy image is dark. The copy density is set darker. Make the density lighter if you use the manual copy density 

mode.

The copied image is stained. The platen cover or the Automatic 

Document Feeder is not lowered 

fully.

Lower it fully to block outside light.

The original glass or platen sheet 

is dirty.

Clean them.

 P.104 “Regular Cleaning”

The copy density is set darker. Make the density lighter if you use the manual copy density 

mode.

Highly transparent originals such 

as overhead transparencies or 

tracing paper are used.

Place a blank plain sheet of paper, the same size as the 

original or larger, over the original.

The copy image is fogged. There is a slight gap between the 

original glass and the original.

Lower the platen cover or the Automatic Document Feeder 

fully so that the original will contact with the original glass.

The paper is damp. Replace with dry paper.

The copy image is partially 

missing.

The size or direction of the paper 

and the original, or the 

reproduction ratio is not set 

properly.

Use paper of the same size as the original or set the 

reproduction ratio suitable to the paper size.

The copy image has black 

streaks in a horizontal direction.

The charger is dirty. Clean the charger.
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Regular Cleaning

We recommend you to clean the following items weekly, so that the originals can be scanned in unsoiled conditions. Be 

careful not to scratch the parts that you are cleaning.

 Be careful not to scratch the portions in cleaning.

 When cleaning the surface of the equipment, do not use such organic solvents as thinner or benzine.

- This could warp the shape of the surface or leave it discolored.

 When using a chemical cleaning pad to clean it, follow the instructions.

For Europe

For regions other than Europe

1. Scanning area (surface of the long rectangular glass) / 2. Original glass

Wipe it with a soft dry cloth. If there are still stains remaining, wipe it clean with a piece of soft cloth which has been 

moistened with water and then squeezed well.

Do not use liquids other than water (such as alcohol, organic solvents or neutral detergent).

3. Platen sheet / 4. Guide

Clean the surface as follows depending on the staining.

 Clean it with a soft cloth.

 Clean it with a soft cloth lightly moistened with water.

 Clean it with a soft cloth lightly moistened with alcohol, and then wipe it with a dry cloth.

 Clean it with a soft cloth lightly moistened with watered-down neutral detergent, and then wipe it with a dry cloth.

You need to clean 1 (scanning area) and 4 (guide) only when using Automatic Document Feeder.

32
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e-STUDIO2505 Specifications

 These specifications vary depending on the copying conditions and the environment.

 Specifications and appearance are subject to change without notice in the interest of product improvement.

Model name DP-2505

Type Desktop type

Original glass Fixed

Printing (copying) system Indirect electrophotographic method

Developing system 2-component magnetic brush developing

Fusing method One halogen lamp

Photosensor type OPC

Original scanning system Flat surface scanning system

(When the Automatic Document Feeder is installed: Fixed scanning system by 

feeding the original)

Original scanning sensor Linear CMOS sensor

Scanning light source LED

Resolution Writing 2400 dpi x 600 dpi (Smoothing process)

Scanning 600 dpi x 600 dpi

Acceptable originals Sheets and books

Acceptable original size Original glass: Max. A4 or LT

ADF: Max. A3 or LD

Acceptable paper size Drawer A4, 16K, LT

Bypass A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO, LD, LG, LT, LT-R, ST-R, COMP, 

13"LG, 8.5"SQ, 8K, 16K, 16K-R

Acceptable paper weight Drawer 64 - 80 g/m2 (17 - 20 lb. Bond)

Bypass 64 - 80 g/m2 (17 - 20 lb. Bond): for continuous feed

52 - 63 g/m2 (14 lb. Bond - 17 lb. Bond), 81 - 163 g/m2 (21 lb. Bond - 43 lb. 

Bond): for single feed

Warm-up time Approx. 20 seconds

First copy time (A4 or LT portrait) LT: Approx. 7.1 seconds

A4: Approx. 7.0 seconds

Continuous copy speed See  P.107 “Continuous copying speed”

Multiple copying Up to 999 copies

Excluded image width Copy Leading edge: 3.0±2.0 mm (0.12"±0.08")

Trailing edge: 2.0±2.0 mm (0.08"±0.08")

Both edges: 2.0±2.0 mm (0.08"±0.08")

Printer Leading edge: 3.0±2.0 mm (0.12"±0.08")

Trailing edge: 2.0±2.0 mm (0.08"±0.08")

Both edges: 2.0±2.0 mm (0.08"±0.08")

Reproduction ratio Actual size 100±0.5% 

Zoom 25 - 400% (in 1% increments)

Storage capacity Max. 50 sheets or until the memory is full (TOSHIBA’s own chart)

Paper supply Drawer 250 sheets (80 g/m2, 20 lb. Bond)

Bypass 50 sheets (80 g/m2, 20 lb. Bond)

Loading capacity for the receiving tray Approx. 100 sheets (80 g/m2, 20 lb. Bond)

Toner density adjustment Magnetic auto-toner system

Exposure control Automatic plus manual selection from 9 exposure steps

Memory 128 MB

USB interface USB2.0 (Hi-Speed)

Environment (for normal use) Temperature: 10 º - 30 ºC, Humidity: 20 - 85% (No condensation)

Power requirements and power consumption

(including optional equipments)

AC 220-240 V±10%, 8 A (50-60 Hz): 1.0 kW or less

AC 120 V±10%, 12 A (60 Hz): 1.0 kW or less

Dimensions (including equipment and platen cover) 390 mm (15.4") (W) x 540 mm (21.3") (D) x 435 mm (17.1") (H)

Weight (including equipment and drum) Approx. 22.0kg (48.5 lb.) (Approx. 20.5 kg (45.2 lb.) for some destinations)

Space occupied (equipment only) 850 mm (33.5") (W) x 540 mm (21.3") (D)
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8 SPECIFICATIONS

̈Continuous copying speed

sheets/min.

* A3 and LD can be loaded only on the bypass tray.

 The values above are measured when originals are set on the original glass, 100% and nonsort multiple copies are 

made.

 TOSHIBA-recommended paper is used for the values of the specifications above.

 The bypass copying speed is as listed above when specifying the paper size.

 This specification varies depending on the copying conditions and the environment.

Paper size Paper source Copying speed

A4, A5-R, B5, LT, ST-R Drawer 25*

Bypass tray 25

A4-R, B5-R, LT-R Drawer -*

Bypass tray 19

B4, FOLIO, LG, COMP Drawer -*

Bypass tray 16

A3, LD Drawer -*

Bypass tray 14
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Specifications of Options

Automatic Document Feeder (Only for Europe) 

Model name MR-2021

Copy sides 1-side

Number of originals (A4) 50 originals (80 g/m2, 20 lb. Bond) or 9.5 mm or less in height (more than 80 g/m2, 20 lb. Bond)

Feeding speed 20 sheets/min. (A4, LT)

Acceptable originals A3, A4, A5-R, B4, B5, LG, LT, LD, ST-R

Paper weight 50 - 104 g/m2, 13 - 27 lb. Bond

Power source Power supplied from the equipment

Dimensions 385 mm (15.16") (W) x 445 mm (17.52") (D) x 88 mm (3.46") (H)

Weight Approx. 3.6 kg (7.9 lb)

Power consumption 40 W max.
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Packing List

Packing list Safety Information

Quick Guide

Power cable

DVD
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Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes *1 Yes Yes Yes Yes Yes Yes Yes

APS Yes No No Yes No *2 No *2 No *2 Yes Yes Yes Yes Yes No *2 No *2 No *2 Yes Yes Yes Yes Yes

Drawer Yes No No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Bypass Yes No No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

AMS Yes No *3 Yes Yes Yes No No Yes Yes Yes Yes Yes No *3 No *4 No *4 Yes Yes Yes Yes Yes

Manual Yes No *3 Yes Yes Yes No No Yes Yes Yes Yes Yes No *3 No *4 No *4 Yes Yes Yes Yes Yes

Fixed Zoom Yes No *3 Yes Yes Yes No No Yes Yes Yes Yes Yes No *3 No *4 No *4 Yes Yes Yes Yes Yes

Text/Photo Yes Yes Yes Yes Yes Yes Yes Yes No No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Text Yes Yes Yes Yes Yes Yes Yes Yes No No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Photo Yes Yes Yes Yes Yes Yes Yes Yes No No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Auto Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No Yes Yes Yes Yes Yes Yes Yes Yes

Manual Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No Yes Yes Yes Yes Yes Yes Yes Yes

Yes *1 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

2IN1 Yes Yes Yes Yes Yes Yes Yes Yes Yes No Yes Yes Yes

4IN1 Yes Yes Yes Yes Yes Yes Yes Yes Yes No Yes Yes Yes

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Non Sort No *5 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No Yes

Sort Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No Yes

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Notes

Yes: The functions can be combined.
No: Current setting is cancelled, next setting will be selected.
   : Next setting can't be selected.
*1: Can't start job.
*2: Drawer will be selected.
*3: 100% will be selected.
*4: The appropriate zoom ratio will be selected.
*5: Sort will be selected.
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ID Card
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Finishing
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Shift

Edge

Erase
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ADF (Original Set on ADF)
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Photo Auto Manual
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APS
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Photo

Next setting
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AMS Manual
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Zoom
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Annotati
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Image Shift
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Annotation

Already setting
BypassDrawer
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(Original
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2IN1/4IN1 ....................................................86, 88, 89

A

AC-IN terminal ...........................................................10
ADF⁄ Platen ..............................................................82
Alert lamp .................................................................12
AMS (Automatic Magnification Selection) .....................37
Angle ................................................................. 68, 76
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APS (Automatic Paper Selection) ................................35
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AUTO DRAWER CHANGE .................................. 88, 89
AUTO POWER SAVE ................................................88
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Automatic Paper Selection (APS) ................................35

B

BACKGROUND .................................................. 88, 89
[Basic] tab ....................................................61, 62, 71
Bypass tray .......................................................... 8, 15

C

[CANCEL] button .......................................................12
Caption .............................................................. 68, 76
Center Watermark ......................................................68
CHANGE LANGUAGE ...............................................88
[CLEAR/STOP] button ................................................11
Configuration of options ..............................................10
Configuration Settings ................................................50
[Configuration] tab ............................................... 61, 70
Considerations ..........................................................55
Continuous copying speed ........................................107
Control panel ........................................................ 9, 10
COPY ................................................................ 88, 89
Copy Handling .................................................... 64, 72
Copy quantity ............................................................12
COUNTER ......................................................... 88, 90

D

Default Menu Setting ..................................................69
Digital keys ...............................................................11
Direction of Print ................................................. 65, 74
Distinguish Thin Lines ................................................66
Do not Print Blank Pages ............................................69
Draw as Outline .................................................. 68, 76
Draw Borders Around Pages ................................ 65, 74
DRAWER .....................................................86, 88, 89
Drawer ................................................................. 8, 15
DRAWER 1 ........................................................ 88, 89
DRAWER SET ..........................................................88
Drawer Settings .........................................................70

E

Easy Set ...................................................................83
EDGE ERASE ...........................................................86
[Effect] tab ....................................................61, 67, 75
[ENERGY SAVER] button ...........................................11
 ................................................................................82
Enlarging copy ...........................................................37
Envelope ............................................................ 15, 21
EXPOSURE .......................................... 31, 86, 88, 89
Exposure ..................................................................12
[EXPOSURE] button ..................................................31
Exposure/Contrast .....................................................82

F

FINISHING ............................................................... 86
[Finishing] tab ...............................................61, 64, 72
Font Name ......................................................... 68, 76
Font Size ...........................................................68, 76
Front cover ................................................................. 8
[FUNCTION CLEAR] button ....................................... 11

G

GENERAL ................................................................ 88

H

Help ......................................................................... 61
How to print .............................................................. 55

I

ID CARD ............................................................ 31, 86
[ID CARD] button ...................................................... 31
[Image Quality] tab ..............................................61, 66
IMAGE ROTATION .............................................88, 89
IMAGE SHIFT .......................................................... 86
INFORMATION ...................................................88, 90
Initial values ............................................................. 57

L

LCD CONTRAST ...................................................... 88
LCD screen .............................................................. 11
Limitations ................................................................ 55
Low power mode ....................................................... 13

M

Main screen (Copy) ................................................... 12
Manual 2-Side Printing .............................................. 65
Manual Scale ...................................................... 62, 71
MAXIMUM COPIES ............................................ 88, 89
Maximum number of originals ..................................... 26
Menu Tabs ............................................................... 61
Message ............................................................ 12, 92

N

Number of Copies ..................................................... 63
Number of pages per Sheet .................................65, 74

O

[OK] button ............................................................... 12
Orientation ............................................................... 63
ORIG. ORIENTATION ......................................... 88, 89
Original glass .............................................................. 9
ORIGINAL MODE .................................. 32, 86, 88, 89
Original Mode ........................................................... 82
Original mode ..................................................... 12, 34
[ORIGINAL MODE] button ......................................... 32
Original Paper Size .............................................62, 71
Original scale ............................................................ 10
ORIGINAL SIZE .................................................. 88, 89
Original Size ............................................................. 82
[Others] tab ........................................................61, 69

P

Packing list ............................................................. 109
PAGE LAYOUT .................................................. 88, 89
Paper exit stopper ....................................................... 9
PAPER JAM RECOVERY .......................................... 88
Paper misfeed (ADF) ................................................. 94
Paper misfeed (bypass tray) ....................................... 95
Paper misfeed (transfer unit) ...................................... 96
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PAPER SIZE ...................................................... 88, 89
Paper size .......................................................... 12, 15
Paper Source ............................................................62
Paper source .............................................................35
Paper Type ...............................................................63
Paper types not acceptable .........................................16
Plain paper ................................................................15
Platen cover ................................................................8
Platen sheet ..............................................................10
POP UP ....................................................................88
Power switch ........................................................ 9, 13
Precautions for Automatic Document Feeder ................26
Pre-Scan ...................................................................80
Preview window .........................................................61
Print on First Page Only ....................................... 67, 75
Print Options .............................................................57
Print Paper Size .................................................. 62, 71
PRINTER ........................................................... 88, 89
Printer Name .............................................................60
Profile ................................................................ 58, 61

R

Receiving tray ............................................................10
Recommended paper .................................................16
Reducing copy ...........................................................37
Reproduction ratio ......................................................12
Resolution .................................................................82
Restore Defaults ................................................. 68, 70
Resuming .................................................................29
RGB Adjustment ........................................................82
Rotate 180 Degrees ...................................................67
Rotation ....................................................................82

S

Saturation .................................................................82
Scan .........................................................................80
Scan options .............................................................81
Scanning area ...........................................................10
Scroll icon .................................................................12
[SETTINGS] button ....................................................11
Sharp .......................................................................82
SHARPNESS ..................................................... 88, 89
Side cover ...................................................................8
SLEEP MODE ...........................................................88
Sleep mode ...............................................................13
Smoothing .................................................................66
Solid .................................................................. 68, 76
SORT MODE PRIORITY ..................................... 88, 89
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Specifications of options ...........................................108
[START] button ..........................................................11
Sticker labels .............................................................15
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Storing paper .............................................................16
Style .........................................................................68
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tab ............................................................................82
Thick paper ...............................................................15
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TIMERS ....................................................................88
Toner cartridge ..................................................... 8, 98
TONER EMPTY .........................................................98
TONER REMAIN ................................................ 88, 90
Toner Save ...............................................................69
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Tracing paper ........................................................... 15
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Transparency ..................................................... 68, 76
TWAIN ..................................................................... 80
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Units ........................................................................ 68
USB terminal ............................................................ 10
Use Black for All Text ................................................ 66
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